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processing devices; RF solutions; discrete components; enterprise storage and communication
solutions; security technologies and scalable anti-tamper products; Ethernet solutions; Power-
over-Ethernet ICs and midspans; as well as custom design capabilities and services. Microsemi
is headquartered in Aliso Viejo, California, and has approximately 4,800 employees globally.
Learn more at www.microsemi.com.
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Welcome to SmartPower

Welcome to SmartPower, the Microsemi SoC state-of-the-art power analysis tool. SmartPower enables you to
globally and in-depth visualize power consumption and potential power consumption problems within your design,
so you can make adjustments — when possible — to reduce power.

SmartPower provides a detailed and accurate way to analyze designs for Microsemi SoC FPGAs: from top-level
summaries to deep down specific functions within the design, such as gates, nets, 10s, memories, clock domains,
blocks, and power supply rails.

You can analyze the hierarchy of block instances and specific instances within a hierarchy, and each can be
broken down in different ways to show the respective power consumption of the component pieces.

SmartPower also analyses power by functional modes, such as Active, Flash*Freeze, Shutdown, Sleep, or Static,
depending on the specific FPGA family used. You can also create custom modes that may have been created in
the design. Custom modes can also be used for testing "what if* potential operating modes.

SmartPower has a very unique feature that enables you to create test scenario profiles. A profile enables you to
create sets of operational modes, so you can understand the average power consumed by this combination of
functional modes. An example may be a combination of Active, Sleep, and Flash*Freeze modes — as would be
used over time in an actual application.

SmartPower generates detailed hierarchical reports of the power consumption of a design for easy evaluation.
This enables you to locate the power consumption source and take appropriate action to reduce the power if
possible.

SmartPower supports use of files in the Value-Change Dump (VCD) format, as specified in the IEEE 1364
standard, generated by the simulation runs. Support for this format lets you generate switching activity information
from ModelSim or other simulators, and then utilize the switching activity-over-time results to evaluate average
and peak power consumption for your design.

Starting SmartPower
Note: When you launch SmartPower, you must first set your target clock and data frequencies before you
evaluate your power consumption.

To invoke the SmartPower analysis tool, in the Design Flow window, right-click Verify Power and choose Open
Interactively.
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Figure 1 - SmartPower User Interface
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SmartPower Interface

Summary Tab

The Summary tab is divided into five sections: Power Consumption, Breakdown, Annotation Coverage,
Operating Conditions, and Battery Life.

%Suﬂ"ﬂaﬂ' IP@ Domainzs . ﬁﬁ.ﬂ.nalysis . QU Frequencies . e[}thahiI'rtes ]

Power Consurnption

Total 0042 mw
Static 0042 mw
Diynamic 0 mw
Breakdown—| By Type - Show @ Chat © Grid

Power Usage

Banks Static
0.008 v

Hide annaotation coverage

Annotation Coverage —| Frequencys=0 A
YCD Manual SmartTime Vectorless .
Frequency>=0 Annotation = Annotation Constraint E stimation Fixed Values | Taotal
1 |Clocks 010%) 010%) 010%) 010%) 5 [100%) ]
2 |FRegister outputs 010%) 0[0%) [ uEA] [ uEA] 18 (100%) 18
3 | Combinational outputs 010%) 01[0%) 0[0z) 0[0z) 53 (100%) ]
4 | Set/Feset nety 010%) 010%) 010%) 010%) 4[100%) 4
5 | Primary inputs 01[0%) 0[0%) 0[0%) 0[0%) 9[100%) 9
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1 @ Junction Temperature oaC
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Change Opersting Conditions
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B attery capacity 1000.00 méHrs
B attery life 2994012 Howrg)

Figure 2 - SmartPower Summary Tab

Power Consumption

Displays the total power consumption and the static and dynamic power of the design. (Accurate only after you
have entered your target clock and data frequencies).
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Breakdown

Displays a breakdown of power consumption in the design. You can specify whether to see the power breakdown
by type of component, by voltage rail, or by clock domain from the drop-down list.

Show

Displays power usage as a chart or as a grid.

When you select By Type from the drop-down list, the Summary tab displays a breakdown of the design's power
usage by the following types:

o Net

e Gate

e |/O

e Memory

e Core Static
e Banks Static

Any static power used by instances of a component in a design will be included in the appropriate category. As a
result, the sum of the power in breakdown by type will equal the total of the static and dynamic power
consumption of the design. Percentages displayed are fractions of the total power. Global nets are included in the
net power types. To obtain the power of a clock, select breakdown by clock domain.

When you select By Rail from the drop-down list, the Summary tab displays a breakdown of the power usage by
the rail that the power is drawn from and a breakdown for the current usage. For each rail, the power, voltage,
and current drawn are displayed.

When you select By Clock Domain from the drop-down list, the Summary tab displays a breakdown of the power
usage by the clock domain that the power is drawn from. For each clock domain, the power and percentage of
power drawn are displayed. Dynamic power is accounted for in breakdown by clock, but static power is not
associated by any clock.

When you select By Mode — available only when a scenario is selected in the Modes and Scenarios toolbar —
the Summary tab displays power consumption, duration and power duration weight by mode.

Whether you selected By Type, By Rail, By Mode, or By Clock Domain, you can customize which columns are
displayed in the grid by right-clicking the column headers. To exclude a column, remove its checkmark from the
right-click menu. Right-click a column header to set the column default size for the selected column or for all
columns, sort the values in ascending or descending order, or customize columns.

To sort the contents of a column, double-click a column header.

To export the contents of the grid to a file, from the File menu, choose Export Grid or click its associated toolbar
button.

To print the grid, from the File menu, choose Print Grid or click its associated toolbar button.
To copy the grid, from the Edit menu, choose Copy Grid or click its toolbar button.

To copy the chart, click the contents of the chart, and from the right-click menu, choose Copy Chart to
Clipboard.

To export the chart, click the contents of the chart, and from the right-click menu, choose Export Chart to File.

To rotate the chart by 90 degrees, click the contents of the chart, and from the right-click menu, choose Rotate
Chart Clockwise or Rotate Chart Counter-Clockwise.

Annotation Coverage

Displays the number and percentage of pins annotated by each source (VCD, manual annotation, SmartTime
constraint, vectorless estimation, and fixed values) for all clocks, register outputs, combinational outputs, set/reset
nets, primary inputs, enable pins, and other pins.

To hide/show the annotation coverage, click the Hide annotation coverage or Show annotation coverage link.

Use the Annotation Coverage Summary drop-down menu to view probability or frequency annotation statistics
(frequency=0 shows statistics for pins that have a frequency of 0).

VCD: displays the number/percentage of pins with frequencies/probabilities imported from a VCD file.
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Manual annotation: displays the percentage of pins with manually-annotated frequencies/probabilities.
SmartTime constraint: displays the percentage of pins initialized with SmartTime.
Fixed values: displays the percentage of pins with default frequency/probability.

Vectorless estimation: displays the percentage of pins that have been annotated with vectorless
estimation.

Operating Conditions
Displays the temperature and voltage operating conditions for the selected mode or scenario as specified in the
Operating Conditions dialog box. When you select a scenario, the temperature and voltage operating conditions
for each mode in the scenario are displayed.

To change the operating conditions, click the Change Operating Conditions link or from the Tools menu,
choose Operating Conditions.

Battery Life
Enables you to set the battery capacity in mA/hr and reports the battery life.

Domains Tab

The Domains tab displays a list of existing domains with their corresponding clock and data frequencies and
probabilities.

When you start SmartPower for the first time, it will automatically initialize frequencies from SmartTime with a
default data toggle rate of 10%. However, if you update your timing constraints in SmartTime, you can use the
Initialize Frequencies and Probabilities dialog box to update SmartPower with new frequencies from SmartTime. If
you don't have timing constraints in SmartTime, you can manually initialize clock and data frequencies by directly
editing the Domains tab grid, or you can use the Initialize Frequencies and Probabilities dialog box.

If you import a VCD file, the Domains tab will display average clock and data frequencies for each clock domain
and input set. This average is calculated using VCD information.

Note: If you change a clock or data frequency in the Domains tab, it will only impact nets using the default
estimation source. Nets use the default estimation source when they have not been manually set to a
specific frequency in the Frequencies tab, and when they have not been set by importing a VCD file.
To see explicitly the list of nets using the default estimation source, refer to the Frequencies tab.

%Summary ?@Dnmains |,09 Dnalyzis [ (‘9 Frequencies [ %thahil'ﬁes l

Show : & " Probabilties
Clock domairs
stat N Clocks Register Set/Reset | Primary inputs Combinational
atus ame ({MHz) outputs nets (MHz} outputs {MHz)
1 o  |CLKIN 100 5 (10 %) 000 %) S (10 %) 5 (10 %)
Hide set of ping
Set of ping
Data
Status Name - {MHz})
1 Py Input to Output i
Frequencies and Probabilities displayed in this tab are default values. They are used for nets that have not been annotated by any method (i.e. YCD or manual
annotation). Chanaing these values may not impact power estimation, depending on the percentage of nets annotated.

Figure 3 - SmartPower Domains Tab
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Note: Data and clock frequencies are automatically set to zero when in non-active modes.

The Domains tab displays frequencies or probability data for clock domains and sets of pins. In this tab, you can
add, edit, or remove domains or sets of pins, and change the clock and/or data frequency of a selected domain.

To hide or display the grid for set of pins, click the Hide/Show set of pins link.
You can edit frequency or probability data directly from the grid.

To create a new clock domain or set of pins:

1. Right-click the clock domain or set of pins and choose to add a new create new clock domain or create
new set of pins.

2. Enter a name and click OK. The new clock domain or set of pins appears in the Domains tab.
3. Modify the frequency and probability data as needed.

Clock domain frequencies can be initialized by right-clicking the clock domain name and selecting Initialize
Frequencies and Probabilities. If there is no frequency constraint set for this clock domain in SmartTime, the
clock frequency of the domain will not be changed.

The status of a clock frequency or probability is displayed in the first column by an icon. Mouse over the icon to
identify the status:

Table 1 - Clock Frequency/Probability Status

Icon Description

This clock has not been initialized

No constraints available for this clock from SmartTime

Average frequencies/probabilities imported from VCD

Clock constraints imported from SmartTime

NN ENEE

This clock has been manually initialized

Note: This feature is only available when in active operating mode or when in a mode based on the Active
mode.

The status of a set of pins is displayed in the first column by an icon. Mouse over the icon to identify the status:
Table 2 - Set of Pins Status

Icon Description
FAN This set has not been initialized
\,/ Average frequencies/probabilities imported from VCD
\./ This set has been manually initialized

Note: This feature is only available when in active operating mode or when in a mode based on the Active
mode.

To remove one or multiple clock domains, select the clock domain(s), and click Remove Selected Domains(s).
To edit a clock domain or a set of pins:

1. Select the clock domain and from the right-click menu, choose Edit Domain. The Clock Domain or Set-of-
Pins window appears.
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Figure 4 - Clock Domain Window

Any pins that do not belong to a domain are listed in the Unclassified Pins list box. You can select a pin
from the Unclassified Pins list box and add it to the current domain. You may also select a pin from the
current domain and remove it from the domain (this pin will appear in the Unclassified Pins list box).
Clock Pins and Data Pins: Select Clock Pins from the pull-down list to display all clock pins for the
selected domain, or select Data Pins to display registers, asynchronous signals, primary input, and
combinational signals for the selected domain.

Use the filter boxes to narrow your search for a specific pin. The boxes are text filters; * is a wildcard.

2. Click OK.

To delete a clock domain or a set-of-pins, select the clock domain or set-of-pins and from the right-click menu,
choose Remove Domain.

Analysis Tab

The Analysis tab enables you to inspect detailed hierarchical reports of the power consumption. The Analysis
tab consists of two windows: the Hierarchy of Instances window and the Analysis window.

10
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Figure 5 - SmartPower Analysis Tab

Hierarchy of Instances Window

SmartPower displays the hierarchy of instances in a list in the Hierarchy of Instances window. Sub-blocks of a
block are shown in the tree when you click the plus sign (+) next to the block. Only hierarchical blocks are
displayed in this list (no gates or nets).

When you select a block of the hierarchical tree, SmartPower displays its name and power consumption in the
Analysis window.

Analysis Window
The Analysis window is divided into two sections: Power Consumption and Breakdown.

Power Consumption

Displays the name of the currently selected block from the hierarchy of instances window, as well as the static
and dynamic power consumption of the selected block.

Show

Displays power usage as a chart (not available when breakdown by instance is selected) or as a grid.

Breakdown

Displays a breakdown of power usage of the currently selected block. Use the drop-down list to select whether to
display the power breakdown by type of component, instance, or clock domain.

When you select By Type from the drop-down list, the Analysis tab displays a breakdown of the selected block's
power usage by the following types:

o Net

e Gate

e |/O

e Memory

11
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e Core Static
e Banks Static
e Analog

Any static power used by instances of a component in a design will be included in the appropriate category. As a
result, the sum of the power in breakdown by type will equal the total of the static and dynamic power
consumption of the design. Percentages displayed are fractions of the total power. Global nets are included in the
net power types. To obtain the power of a clock, select breakdown by clock domain.

When you select By Clock Domain from the drop-down list, the Analysis tab displays a breakdown of the power
usage by the clock domain that the power is drawn from. For each clock domain, the power and percentage of
power drawn are displayed. Dynamic power is accounted for in breakdown by clock, but static power is not
associated by any clock.

Whether you selected By Type, By Instance or By Clock Domain, you can customize which columns are
displayed in the grid by right-clicking the column headers. To exclude a column, remove its checkmark from the
right-click menu. Right-click a column header to set the column default size for the selected column or for all
columns, sort the values in ascending or descending order, or customize columns.

To sort the contents of a column, double-click a column header.

To export the contents of the grid to a file, from the File menu, choose Export Grid or click its associated toolbar
button.

To print the grid, from the File menu, choose Print Grid or click its associated toolbar button.
To copy the grid, from the Edit menu, choose Copy Grid or click its toolbar button.

To copy the chart, click the contents of the chart, and from the right-click menu, choose Copy Chart to
Clipboard.

To export the chart, click the contents of the chart, and from the right-click menu, choose Export Chart to File.
To rotate the chart by 90 degrees, click the contents of the chart, and from the right-click menu, choose Rotate
Chart Clockwise or Rotate Chart Counter-Clockwise.

To view an instance properties, right-click any instance and select Instance Properties. This brings the Instance
Properties window, which displays the instance name, type and power and other properties specific to each type
of instance, see image below.

See Also

Help

Close

Instance Properties E|

Property | Yalue |

Mame 141

Paower 'y

Twpe (aake

Macro AOLIEIMY
Pin List:

Pin et | Comnain | Freq. (MHz) |

Ui41:4 BusCutput CPUCHK (data) 0,000

141y DRAMDa&ta .., CPUCHk {datay 0,000

Figure 6 - Instance Properties: Gate
The Instance Properties allows you to access a list of pins of a gate and to check their domain and frequency.

Analyze results

12
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Advanced Analysis of 1/0Os

Frequencies Tab

Use the Frequencies tab to attach switching frequency attributes to the interconnects of the design. The
Frequencies tab is divided into Switching Frequencies, Average Frequencies, and Annotation Statistics.

% surmmmary . i Dormains - O pnabysis [ Frequencies lg{}thahil'mes l

Switching Frequencies:
Driver: |* Set Domain: | &l - Source: Al -
_ R Frequency M
Driver Net Domain {MHz) Source
1 |PWM_out_pad/U0UL:DOUT PWM_out_pad/U0/METL unl_dataa_int 0 Fixed Walues
2 |PWM_out_pad/UD/UD:PAD | PWM_out unl_dataa_int 0 Fixed Walues
3 nPwWM_out_pad/U0/UL:DOU nPWM_out_pad/UD/NETL unl_dataa_int 0 Fixed Walues
4 | nPWM_out_pad/U0SU0PAD [nPWM_out unl_dataa_int 0 Fixed Walues
5 |unl_dataa_int_ME:Y unl_dataa_int_ME unl_dataa_int 0 Fixed Walues
6 PWM_out:Q PWM_out_c unl_dataa_int 0 Fixed Walues
7 nPwM_out:Q nPWM_out_c unl_dataa_int 0 Fixed Walues
g | Aclr_pad/U0/00:0 Aclr_pad/U0METL Pwh_clk (set/ 0 Fixed Walues
9 PWM_clk Pl Pwt_clk {cloc 0 Fixed Walues
10 |PwWM_clk_pad U000 PwW_clk_pad/U0/METL Pwt_clk {cloc 0 Fixed Walues
11 |PWM_data_in=5= PwW_data_in[5S] Pt _clk (prim 0 Fixed Values
12 |PWM_data_in=3= PwW_data_in[3] Pt _clk (prim 0 Fixed VWalues b
Select all
Awerage Frequencies: Annotation Statistics:
WCD Import: 0%
Pir: 1] MHz b aral Annokation: 0%
Fixed Walues: 100 %
Wectorless Estirmation: 0%

Figure 7 - SmartPower Frequencies Tab

Switching Frequencies
Displays the pins and lists the net, domain, frequency, and frequency source for each pin.

The Driver box enables you to filter the list of pins based on the criteria entered. Enter text in the filter box, and
click Set to apply this text as a filter. Use the * character to display all pins or as a wildcard.

Use the Domain drop-down list to select a different domain (All, CLKIN, Default, or Input to Output).
Use the Source drop-down list to select a different source (All, Default, Manual Annotation, or VCD Import).

You can change the frequency by entering a new value in the Frequency column or by selecting multiple pins
and pressing the Set frequencies for selected pins button and entering a new frequency. Use Reset
frequencies for selected pins to revert to the default frequency.

To select all the pins, click Select All.

Average Frequencies
Displays the average frequency of all pins displayed in the grid.
Average Frequencies are useful when you import a VCD file or SAIF file. Since these files enable you to specify
the frequency of each pin individually, it is often useful to know the average clock pin or data pin frequency for a
particular clock domain.
If you did not specify a frequency annotation for any clock pin in this clock domain, the average value is equal to
the default clock frequency of the clock domain. If you set one or several clock pins, SmartPower takes these
specific annotations into account to compute an average value.

13
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If you did not specify a frequency annotation for any data pin in this clock domain, the average value is equal to
the default data frequency of the clock domain. If you set one or several data pins, SmartPower takes these
specific annotations into account to compute an average value.

Annotation Statistics
VCD import: displays the percentage of pins with frequencies imported from the *.vcd file.
Manual annotation: displays the percentage of pins with manually-annotated frequencies.
Fixed values: displays the percentage of pins with default frequency.

Probabilities Tab

You can use the Probabilities tab to control the probabilities for all pins.

Bidirectional and Tristate I/Os: Controls the output probability of each tristate and bidirectional 1/0. The
probability is the percent of time that the I/O is used as an output. You can change the default value and set a
specific value for each bidirectional or tristate 1/0.

Memories: Controls the read cycle probability or the write cycle probability of a memory block. The probability is
the percent of time that a memory block will be used either in a read cycle or a write cycle. You can change the
default value as well as set a specific value for each enable pin of each memory block available in the design.

If an enable pin is active low, assign it a probability of 0% to completely enable the I/O or the memory block, or
100% to disable it completely.

In designs with a cascaded memory, all memory enable pins are shown in the Probabilities tab. To simulate real-
world power consumption, selectively enable only some memory enable pins, as specified in the memory
cascading structure. For purely vertical cascading, enable the pins belonging to one RAM block. For purely
horizontal cascading, enable all pins belonging to all RAM blocks of the cascaded memory. You can find which
RAM block corresponds to which pin by cross-probing with the MVN NetlistViewer.

The Probabilities tab displays the drivers, nets, types, polarity, rates, and source for each pin.

% Surnmary l l Dormains l S snatysis l &5 Frequencies I2j:- Probabilites ‘

Driver:  |§ Set Type: &l - Polarity: |4l - Source: Al -
Driver Net Type Polarity Pro?:;hh)lhtv Source A
1 rst_n rst_n Input to -- 99,9949 Manual &
Z rst_n_padsU000:0Y rst_n_pad/U0/METL Input to -- 99,9949 Manual &
3 rst_n_padsU0/U1:Y rst_n_c Input to -- 99,9949 Manual &
4 fpu_op=0= fpu_op[0] Input to -- 0 Manual &
5 fpu_op_pad[0]/00/00:%  |(fpu_op_pad[0]/U0/NETL |Input to -- 0 Manual &
5} fpu_op_pad[0]/U0/UL:y (fpu_op_c[0] Input to -- 0.000003 Manual &
7 UUTAunl_fpu_op_5_0_a2 UUT/M_1117 Input to -- 0.000003 Manual &
a UTAfracta_rmul_w_0_az UUT/M_1111 Input to -- 0.000003 Manual &
9 fpu_op<l> fpu_op[1] Input to -- 0 Manual &
10 fpu_op_pad[1]A00/00:7  (fpu_op_pad[1]AU0/METL |Inputto -- ] Manual A
11 fpu_op_pad[1]AU0/U1: v (fpu_op_c[1] Input to -- 0.000003 Manual &
1z UUT Aundl_fpu_op_1_0_aZ |UUT/M_1026 Input to -- 0.000003 Manual &
13 fpu_op=2> fpu_opl[2] Input to -- 0 Manual &
14 fpu_op_pad[2]/00/00:  |[fpu_op_pad[2]/U0/NETL |Input to -- 0 Manual &
15 fpu_op_pad[2]/00/01:  |[fpu_op_c[2] Input to -- 0.000003 Manual &
16 UUTfract_denorm[30]:Q |UUTHract_denorm[30] UUT un3_out_ |-- 0.0125 Manual &
17 UUTfract_denorm[32]:Q |UUTAract_denorm[32] UUT un3_out_ |-- 0.0125 Manual &
1a IIT HFrart damnareal 21100 HINT Frard damaeeal 217 THITAHR2 Aok - nni2c PMariial A ¥
Select al

Figure 8 - SmartPower Probabilities Tab

The Driver box enables you to filter the list of drivers based on the criteria entered. Enter text in the filter box, and
click Set to apply this text as a filter. Use the * character as a wildcard.
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Use the Type drop-down list to filter the pin list by different type (All, All enable, CLKIN, Default, or Input to
Output).
Use the Polarity drop-down list to filter the pin list by polarity (Low, High, or All).

Use the Source drop-down list to filter the pin list by source (All, Default Estimation, Manual Annotation, Saif
Import, or VCD Import).

You can change the rate by entering a new value in the Rate column or by selecting multiple pins, pressing the
Set Probabilities for selected pins button, and entering a new frequency in the Set Default Probabilities dialog
box.

Set probability for pin(s) E|

Probability:

50,00
Ik | Cancel |

Figure 9 - Set Probability for Pins Dialog Box
Use Reset Probabilities for selected pins to revert to the default polarity.
You can change the default probability from the Domains tab.
To select all the drivers, click Select All.

You can set or reset the probabilities, set a default probability, copy, export, or print the grid by selecting one or
multiple pins and choosing an option from the right-click menu.

See Also
Specify probabilities

Preferences Toolbar

The SmartPower Preferences toolbar gives you quick access to commonly used settings. Mouse over the toolbar
button to view a description of the command. Use the drop-down list to select your settings.

Operating Freguency Power
Conditions Preferences  Preferences

IT_I,Ipin::aI j |MH2 j |mW j|
Figure 10 - SmartPower Preferences Toolbar
Operating Conditions: Enables you to set the operating conditions - Best, Typical, or Worst.

The actual voltage and temperature of a given operating condition is defined by the operating condition range
selected for the current design (COM, IND, MIL, Auto, TGradel, TGrade2, and Custom). For SmartPower, unlike
SmartTime, the worst voltage is the upper bound of the range. That is, higher (worst-case) power comes from
higher voltage, whereas higher voltage results in best-case speed.

Note: Worst-case and best-case calculations are available only for certain families and devices.
Frequency: Sets unit preferences for frequency — Hz, KHz, MHz.
Power Units: Sets unit preferences for power — W, mW, or uw.

See Also
SmartPower toolbar / menu commands
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Modes and Scenarios Toolbar

The Modes and Scenarios toolbar displays all pre-defined modes, custom modes, pre-defined scenarios, and
custom scenarios. The Modes and Scenarios toolbar is shown by default, but can be closed or undocked. To view
the toolbar, from the View menu, choose Modes and Scenarios toolbar.

From this toolbar, you can:

Select a pre-defined mode by clicking the mode name
Select a custom mode by clicking the mode name

Select a custom mode for power-driven layout by right-clicking the active-based mode and selecting Use for
PDPR

Re-import a VCD file from an Active mode or a custom mode by right-clicking the VCD file and selecting Re-
import VCD File

Remove a VCD file from an Active mode or a custom mode by right-clicking the VCD file and selecting
Remove VCD File from <mode name> Mode; or from the Simulation menu, choose Remove VCD File
> <file name>

Generate a Cycle-Accurate Power report by right-clicking the VCD file and selecting Cycle-Accurate Power
Report

Generate an Activity and Hazards Power report by right-clicking the VCD file and selecting Activity and
Hazards Power Report

View the Cycle-Accurate Power analysis by right-clicking the VCD file and selecting Cycle-Accurate Power
Analysis

Create a new custom mode by clicking Custom modes and selecting New Custom Mode; or by clicking
the New Custom Mode hyperlink

Edit and delete a custom mode by right-clicking the mode name and selecting Edit custom mode or
Delete custom mode

Copy a custom or a pre-defined mode by right-clicking the mode name and selecting Create a copy of this
mode

Select a scenario by clicking the scenario name

Create a new custom scenario by clicking Scenarios and selecting New custom scenario

Edit and delete a custom scenario by right-clicking the scenario name and selecting Edit custom scenario
or Delete custom scenario

Copy a scenario by right-clicking the scenario name and selecting Create a copy of this scenario

Note: When a scenario is selected, only the Summary tab is available.
Modes and scenarios x
Pre-defined modes

3] Active
Static
FlazhFreeze
Sleep
Cusgtom modes
active_low
Fre-defined scenarios
A0% Flash™Freeze
80% Flash™Freeze
95% Flash*Freeze
Customn scenarios
lovapoer

Figure 11 - Modes and Scenarios Toolbar
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SmartPower Standard Toolbar and Menu Commands

The SmartPower standard toolbar contains commands for performing common SmartPower operations on your

designs. Roll the mouse pointer over the toolbar button to view a description of the button. Click the button to
access the command.

Table 3 - SmartPower Toolbar

Toolbar Button

Description

Commit

@ | @

Settings Summary

Operating Conditions

Options

i |

Export Path Grid

g

Copy Path Grid

Print Grid

Generate Power Report

© B | W

Initialize Frequencies and Probabilities

0

Refreshes Vectorless Estimation

The PC and UNIX workstation versions of SmartPower have the same menus. However, some dialog boxes may
look slightly different on the two platforms due to the different window environments. The functionality is the same

on both platforms, though the locations of the fields and buttons on the dialog boxes may vary. The names of

some fields may also vary between the PC and workstation versions.

File Menu
Menu Description

Commit Commits power information. You must commit your changes if you wish to
save your settings in SmartPower. If you commit your changes, the
information is stored in the .adb file, and your settings are restored the
next time you open your design in SmartPower

Export Grid Exports the selected area of the Report window to a text (.txt) file

Print Grid Prints the selected area of the Report window

Settings Summary Displays a summary of the power settings for the current design

Close Closes SmartPower
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Menu

Sub-Menu

Description

Domains

New Clock Domain

Adds a clock domain

New Set of Pins

Adds a set of pins

Delete Domain

Deletes a clock domain

Edit Domain

Edits a clock domain

Modes and Scenarios

Use for Analysis > mode or
scenario name

Sets the selected mode or scenario to be
used for analysis

Use for PDPR > mode or
scenario name

Sets the selected mode or scenario to be
used for Power-Driven Layout

Custom Modes > New
Custom Mode

Creates a new custom mode

Custom Modes > Edit
Custom Mode

Edits a custom mode

Custom Modes > Delete
Custom Mode

Deletes a custom mode

Custom Scenarios > New
Scenario

Creates a new custom scenario

Custom Scenarios > Edit
Scenario

Edits a custom scenario

Custom Scenarios > Delete
Scenario

Deletes a custom scenario

Copy Grid — Copies the selected cells of the dynamic
grid onto the clipboard
View Menu
Menu Description

Standard Toolbar

Displays or hides the SmartPower Standard toolbar

Preferences Toolbar

Displays or hides the SmartPower Preferences toolbar

Modes and Scenarios
Toolbar

Displays or hides the Modes and Scenarios toolbar

Unprocessed Simulation
Files Toolbar

Displays or hides the_Unprocessed Simulation Files toolbar
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Menu Description
Customize Columns Selects and orders the columns displayed in the user interface
Reset Window Layout Resets the window layout to the default layout
Tools Menu
Menu Sub-Menu Description
Initialize Frequencies and | — Imports clock constraints from SmartTime and
Probabilities enables the user to input frequencies and

probabilities for the design

Operating Conditions — Enables the user to customize the_operating
conditions used in SmartPower

Options — Invokes the Options dialog box, where you can
set analysis and display preferences

Reports Power Report Generates a power report
Scenario Power Report Generates a scenario power report
Cycle Accurate Power Generates a cycle accurate power report
Report
Activity and Hazards Generates an activity and hazards power
Power Report report
Cycle Accurate Power — Generates a cycle-accurate power analysis
Analysis

Simulation Menu

Menu Description
Import VCD File Invokes the Import VCD Options dialog box
Remove VCD file Removes the selected CVD file from the design
Audit files Audits simulation files within the project
Help Menu
Menu Description
Help on current tab Displays the help content for the current tab
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Menu Description
Help Topics Opens the help files for SmartPower
SmartPower User's Guide Displays the SmartPower User's Guide
Data Change History Displays the data change history report
See Also

SmartPower preferences toolbar

Power - Settings Summary

The Power - Settings Summary dialog box displays a summary of the power settings for the current design.
To open the Power - Settings Summary dialog box, from the File menu, choose Settings Summary or click the

ﬂ icon in the SmartPower toolbar.

Power - Settings Summary: B x|

Attribute | W alue I
Design SMALL_GATED

Farmnily Prot5IC3

Die A3P125

Fackage 144 FEGA

Temperature Range COk

Yoltage Fange COk

Dperating Conditions Typical

Operating Mode Active

Figure 12 - Power - Settings Summary Dialog Box

The Power - Settings Summary dialog box displays the following information:

e Design: Displays the name of the design.

e Family: Displays the device family used in the design.

e Die: Displays the die.

e Package: Displays the package.

e Temperature Range: Displays the temperature range.

e Voltage Range: Displays the core supply voltage.

e Operating Condition: Displays the operating conditions that SmartPower uses to calculate static and
dynamic power contributions.

e Operating Mode: Displays the operating mode that SmartPower uses to calculate static and dynamic power
contributions.

Note: The status bar also shows the ambient temperature, VCCA and speed grade.

Initializing Frequencies and Probabilities

The Initialize Frequencies and Probabilities dialog box enables you to initialize the frequencies and
probabilities for your design.
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To open the Initialize Frequencies and
Probabilities dialog box, from the Tools menu, choose Initialize Frequencies and

Probabilities, or click the @ icon in the SmartPower toolbar.

Note: This feature is only available in the Active operating mode or modes derived from the Active mode.

The dialog box is organized in the following panels: General, Clocks, Register Outputs, Set/Reset Nets, Primary
Inputs, Combinational Outputs, Enables Sets of Pins, and Other Sets of Pins.

SmartPower - Initialize Frequencies and Probabilities

Selecta Category:

@) General Use this dialog box to initialize frequencies and probabilities For your design.
UL Clacks
1T Register cutputs Initialize: mode: m o
T, SetfReset nets
= Primary inputs
I Combinational outputs
. Set of pins
Enables * |se vectarless analysis
Cthers

o Far pins that have not been annotated, SmartPower can estimated their
frequency and probability using a Yectorless analysis or fixed values,

" Use fixed values

[~ Remaove Simulation File (4CD) i any,

[~ Remove any ranual annotations,

Help [o]'4 | Cancel

Figure 13 - Initialize Frequencies and Probabilities Dialog Box — General

Initialize mode — Select an active-based mode to initialize the frequencies and probabilities for.
For pins that have not been annotated, SmartPower can estimate their frequency and probability using vectorless
analysis or fixed values:
Use vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.
Use fixed values — SmartPower initializes frequencies and probabilities (%) of all registers with a default toggle
rate (available only when using toggle rates), frequency, and probability.
Based on the selected mode, a warning appears with information on the annotated pins. If the selected mode
contains any annotations, you can remove annotations by selecting one or both options below:

Remove simulation file (VCD) if any — Select this option to remove the simulation file for the selected

mode.

Remove any manual annotations — Select this option to remove all manual pin annotations for the
selected mode.
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SmartPower - Initialize Frequencies and Probabilities

@ General

N Clocks
=) Register outputs
T, Set/Reset nets
== Primary inputs

I» Combinational outpuks
. Set of pins
Enables rd

Oth
ors [¥ else, with default frequency 10,00 MHz

and duty cycle 50.00 o,

[v Initialize clock Frequencies and duty cycles

Help Ok | Cancel

Figure 14 - Frequencies and Probabilities Dialog Box — Clocks

Initialize clock frequencies and duty cycles — Select this option to initialize clock frequencies and duty cycles,

with:

with clock constraint if available in SmartTime: When only this box is checked, SmartPower initializes

all clock domains in SmartPower with clock constraints from SmartTime. If there is no frequency

constraint set for this clock domain in SmartTime, the clock frequency of the domain will not be updated.

else, with default frequency (MHz) and duty cycle (%): When only this

box is checked, SmartPower initializes all clock domains in SmartPower with the specified default

frequency and duty cycle.

Note: When both boxes (with clock constraint if available in SmartTime and with default frequency and
duty cycle) are checked, SmartPower initializes all clock domains with clock constraints from

SmartTime. If there is no frequency constraint set for a clock domain in SmartTime, it is initialized

with the specified default frequency and duty cycle.
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Register Outputs

SmartPower - Initialize Frequencies and Probabilities

@ General

N Clocks
F Register outputs
lg‘ Set/Reset nets [¥ Initialize Frequencies and probabilities
== Primary inputs
I» Combinational outpuks
. Set of pins ~
Enables
Others

% with Veckorless analysis

T
—

Help Ok | Cancel

Figure 15 - Frequencies and Probabilities Dialog Box —Registers
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for register

outputs in your design.
With vectorless analysis — SmartPower initializes frequencies and probabilities using vectorless analysis.

With fixed values: SmartPower initializes frequencies and probabilities (%) of all register outputs with a
default toggle rate (available only when using toggle rates) or frequency (when not using toggle rates),
and a default probability.

Set/Reset Nets

SmartPower - Initialize Frequencies and Probabilities

Selccta Category:

{ul General
Ul Clocks
i Register oukputs

= Primary inputs

I» Combinational outputs v Initialize frequencies and probabilities
o Setof pins
Enables with Fized togale rate 0.00 LT
Others

with fized probability 50,00 o

Help [al'4 | Cancel

Figure 16 - Frequencies and Probabilities Dialog Box — Asynchronous

Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for set/reset

nets in your design.
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With default toggle rate (%): SmartPower initializes frequencies and probabilities of all set/reset nets
with the specified default toggle rate. This option is available only when using toggle rates.

With default frequency (MHz): SmartPower initializes all set/reset nets in SmartPower with the specified
default frequency. This option is available only when not using toggle rates.

With default probability (%): SmartPower initializes probabilities of all set/reset nets with the specified
default probability.

Primary Inputs

SmartPower - Initialize Frequencies and Probabilities

{ul General

Ul Clocks
i Register oukputs
T, Set/Reset nets
[ER] Primary inputs

I» Combinational outputs v Initialize frequencies and probabilities
. Set of pins
Enables with fixed togale rate 10.00 LT
Others

with fized probability 50,00 Yo

Help Ok, | Cancel

Figure 17 - Frequencies and Probabilities Dialog Box — Primary Inputs
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the
primary inputs in your design.
With default toggle rate (%): SmartPower initializes frequencies and probabilities of all primary inputs
with the specified default toggle rate. This option is available only when using toggle rates.

With default frequency (MHz): SmartPower initializes all primary inputs in SmartPower with the specified
default frequency. This option is available only when not using toggle rates.

With default probability (%): SmartPower initializes probabilities of all primary inputs with the specified
default probability.
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Combinational Outputs

SmartPower - Initialize Frequencies and Probabilities

@ General
N Clocks
=) Register outputs
lg‘ Set/Reset nets [¥ Initialize Frequencies and probabilities
== Primary inputs
kb Combinational outputs
. Set of pins ~
Enables

Others
Ii

% with Veckorless analysis

Help Ok | Cancel

Figure 18 - Frequencies and Probabilities Dialog Box — Combinational
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the

combinational outputs in your design.
With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.

With fixed values: SmartPower initializes frequencies and probabilities (%) of all combinational outputs
with a default toggle rate (available only when using toggle rates) or frequency (when not using toggle
rates), and a default probability.

Enables

SmartPower - Initialize Frequencies and Probabilities

{ul General
UL Clacks
£ Register outputs ¥ Initialize frequencies and probabilities

T, Set/Reset nets
= Primary inputs

v with Veckorless analysis

I> Combinational outputs '
o Setof pins
ables D . Frequency | Probability
omain MHz %
Others 1 |I0sEnableSet 0.00 12.50
Z MemoriesEnableset 0.0o 1Z.50

Help [al'4 | Cancel

Figure 19 - Frequencies and Probabilities Dialog Box — Enables
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the
enable sets of pins in your design.
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With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.
With fixed values: SmartPower initializes frequencies and probabilities of all enables sets of pins with
the specified default probability and frequency.

Others

SmartPower - Initialize Frequencies and Probabilities

{ul General

Ul Clocks
. [v Initialize frequencies and probabilities
i Register oukputs

T, Set/Reset nets
= Primary inputs

{+ with Vectorless analysis

I+ Combinational outputs primary inputs frequency | 1,00 MHz
i Set of pins primary inputs probability | 50,00 %

Enables

T
T

Help Ok, | Cancel

Figure 20 - Frequencies and Probabilities Dialog Box — Others
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the
other sets of pins in your design with default values.
With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis as
specified in the primary inputs frequency and probability.
With fixed values: SmartPower initializes frequencies and probabilities (%) of all other sets of pins with a
default frequency and probability.

See Also
Domains Tab
Vectorless Analysis

Power Options
Enables you to set options that affect the graphical and textual reports.
To open the SmartPower Power Options dialog box:

e From the File menu choose Options
e Select the Options panel in the Power Report dialog box.

e Click the % icon in the SmartPower toolbar.
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x]

Power - Options

[drits

Power: T, E
Frequency -

[v Llze toggle rates

Help | k. | Cancel |

Figure 21 - SmartPower Preferences Dialog Box
There are two sections: Units and Use Toggle Rates.

e Units: Sets unit preferences for power (W, mW, vW) and frequency (Hz, KHz, MHz).

e Use Toggle Rates: When toggle rates are active (Use Toggle Rates box is checked), the data frequency of
all the clock domains is defined as a function of the clock frequency. This updates the data frequency
automatically when you update the clock frequency. Toggle rates enable you to specify the data frequency
as a percentage of clock frequency, but you can no longer specify the data frequency as a number, only as
a percentage of the clock frequency. To specify data frequencies, clear the Use Toggle Rates option in the
Preferences window.

You can set the data frequency percentage when you create a new clock domain with toggle rates active. In
addition, when toggle rates are active you can set the data frequency percentage in the Domain and Frequencies
tabs.

Create Clock Domain

Patential Clock Fin |l RIS

Cancel |
Clack Frequency I 10 MHz
Data Fregquency I 20 4

Figure 22 - Create Clock Domain — Toggle Rates Enabled

Operating Conditions

The SmartPower Operating Conditions dialog box enables you to customize the operating conditions used in
SmartPower for voltage and temperature.

The General panel enables you to select the operating condition you want to apply to SmartPower: Best, Typical,
or Worst.
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Select a Category:
&F| Genetal

j Temperature settings
+ Thermal resistance settings
[} Volkage settings

WIZCA

WCCI 2.5

WCCT 33

WZCI 1.8

WCCI 1.5

set in Designer.,

Help

|Jse this dialog box to customize the operating conditions used in SmartPower,
Changes will apply only to SmartPower and will not change the operating conditions

Select an active operating condition For
SmartPoveer From the options below:

o]

Cancel

Figure 23 - SmartPower Operating Conditions Dialog Box - General

You can customize temperature settings in the Temperature Settings panel, and the voltage settings in the
Voltage Settings panels — each VCC voltage used in the design appears under Voltage settings.

SmartPower - Operating Conditions

Selecta Category:

@ General
J, ey S2ingE (WE-H Design operating rang
+ Thermal resistance settings
@ Wolkage settings

WCCA

WCCI 2.5

WCCIE3

WCCI 1.8

WCCI1.5

This design uses "COM" settings,

SmartPower uses the operating range specified in the Device Selection Wizard:

Junction Temperature (in degrees Celsius)

Help

Best: Typical; Warsk:
oK | Zancel

Figure 24 - SmartPower Operating Conditions Dialog Box - Temperature Settings
Select one of three options to specify the temperature or voltage settings:

e Design operating range (default): sets the temperature or voltage operating range as specified in your

Project Settings..

e Custom operating range: sets the temperature (junction or ambient) or voltage operating range for the
current design in SmartPower only. You can enter temperature values in degrees Celsius and voltage

values in volts for Best, Typical, and Worst.

¢ Mode by mode operating range: sets the temperature (junction or ambient) or voltage for each mode in
SmartPower only. You can use the grid to enter temperature values in degrees Celsius and voltage values
in volts for each mode, or select multiple modes in the grid, and click the Set values for selected modes
button to enter the same values for all selected modes.
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SmartPower - Operating Conditions

Select a Category: Temperature setting

&F| Genetal -
j TEmEEEiTe GHNEE Use: |Mcn:|e by mode operating range j
+ Thermal resistance settings SmartPower uses a different operating range For each mode,

Operating ranges for each mode can be specified below, They apply ko SmartPower only,

[} ¥altage settings Specify in Celcius degrees):

CCA {* Junction Temperature

WCCI25 " ambient Temperature

WZCI 3.3

WCCI 1B Mode Best Typical Worst

WZCZI1.5
1 Active 0.00 25.00 70.00
2 Sleep 0.00 25.00 R0.00
3 Static 0.00 25.00 R0.00

| Select al
Help Ok, | Cancel |

Figure 25 - SmartPower Operating Conditions Dialog Box - Mode-Specific Temperature Settings

The junction temperature and static power are computed iteratively until they converge.
The formulas are:

T_.f= T/.l‘+ {}M ! (Prﬂ.'.'fr:.-.lr.'.' IPF."{?.":’.‘}
PF&?:‘H= f (Tf) = Pﬂ, + Pl * Tf

If the computed junction temperature is outside the operating condition range (smaller than the best case value or
greater than the worst case value), a violation warning will be reported.

Both T, and Psiwic will be re-computed when any of the following parameters are changed:
e Ambient temperature
e Cooling style
e Custom thermal resistance,
or any parameters/options that affect the static or dynamic power values:
e Junction Temperature Display Mode
e Operating Condition (Affect dynamic power)
e Operating Mode (Affect dynamic power)
e Any of the clock domain frequencies (Affect dynamic power)

If you specified the Ambient temperature in the Temperature Settings panel, you can select the thermal
characteristic for Thetaua .
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SmartPower - Operating Conditions

Select a Category: Thermal resistance
&F| Genetal

j Temperature settings
+ Thermal resistance settings
[} Volkage settings

WCCA
WCCI 2.5 Select the thermal characteristic for Gy,
WCCT 33
% pre-defined:  |ENECHI ~ | 136 Cfw
WZCI1.8
YOOI LS ™ Custom:

Help Ok, | Cancel

Figure 26 - SmartPower Operating Conditions Dialog Box - Thermal Resistance Settings

The thermal resistance is predefined for Still Air, 300 ft/min and Case Cooling. To enter a custom thermal
resistance, select Custom from the Cooling field, and change the value.

SmartPower also reports the thermal resistance, Thetasa.

See Also
SmartPower toolbar / menu commands
SmartPower preferences toolbar

Custom Operating Modes

SmartPower enables you to use pre-defined and custom operating modes. A pre-defined operating mode is an
inherent mode of a family of devices that comes with a number of hard availability constraints on the FPGA
resources. Custom operating modes are user-defined modes based on one of the pre-defined modes available for
the family, where parameters such as clock, data, and toggle rate frequencies have been customized. A custom
mode can also be linked to a VCD.

Custom modes can be used:

e To define additional modes where the chip is in the active pre-defined mode, but where the clock
frequencies or the toggle rates are scaled up or down.

e To import multiple VCD files that capture individual steps that take place in different modes.

e To define a sequence of modes with a duration for each mode and get an estimate of the overall power
consumption, from which extrapolate the battery life for the application. The Scenario Power report enables
you to define a sequence of modes and estimate the weighted average of the power consumption of the
chip over the whole sequence.

e To define additional modes where the chip is in a pre-defined mode, but the junction/ambient temperature or
the rails' voltage modes are different.

To set the current mode:

From the Edit menu in SmartPower, choose Modes and Scenarios > Use for Analysis > mode name; or select
the mode in the Modes and Scenarios toolbar.

To create a new custom mode:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > New Custom
Mode; or click Custom Modes in the Modes and Scenarios toolbar, and select New custom mode. This
brings up the New Custom Mode dialog box.
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Power - New Custom Mode E|
Mame: | Mode3
Based on mode: |F'.|:I:ive j
Comment:

| Frequency 15 MHz|
Help o4 | Cancel |

Figure 27 - New Custom Mode Dialog Box

2. Enter the mode name, select the base mode, and enter comments that describe the mode. The base mode
can be either a user-defined custom mode or the active mode. The new mode will inherit all clock and data
frequencies and annotations of its base mode.

3. Click OK. The newly created operating mode is set as default in the Modes and Scenarios toolbar.

To edit a custom mode:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > Edit Custom
Mode; or right-click the mode in the Modes and Scenarios toolbar, and select Edit custom mode. This
brings up the Edit Custom Mode dialog box.

Power - Edit Custom Mode [custom_mode] E'

MName: cuskom_mode

Cornrnent:

| Copied from "slesp”

This mode is derived From the "Sleep" low power mode.

Help Ik | Cancel

Figure 28 - Edit Custom Mode Dialog Box
2. Edit the mode name and comments.
3. Click OK.

Note: You can only use the Edit Mode dialog box to edit the name and comment of the current mode. To
edit the mode properties such as clock and data frequencies, use the SmartPower tabs.

To copy a custom mode:

1. Right-click the mode in the Modes and Scenarios toolbar, and select Create a copy of this mode. This
brings up the New Custom Mode dialog box.
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Power - New Custom Mode E|
Mame: Copy of Active
Based on mode: |F'.|:I:ive j
Comment:

| Copied from "Ackive"

Help o4 | Cancel |

Figure 29 - New Custom Mode Dialog Box

2. Edit the mode name and comments.
3. Click OK.

To delete a custom mode:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > Delete Custom
Mode; or right-click the mode in the Modes and Scenarios toolbar, and select Delete Mode. This brings up
the Delete Custom Mode dialog box.

Power - Delete Custom Mode [5_<|

Choose the cuskom mode to delete;

Modes

Help K, | Cancel

Figure 30 - Delete Custom Mode Dialog Box
2. Select the mode from the pull down and click OK.
Note: You can only delete custom operating modes. Pre-defined modes cannot be deleted.

Scenarios

A scenario is a sequence of previously defined operating modes with a specific duration for each mode. When
you create a new design, SmartPower will automatically create some pre-defined scenarios that can be used as
is, or copied to create a new scenario based on the pre-defined one.

Note: Pre-defined scenarios cannot be deleted or edited.

To set the current scenario for analysis:

From the Edit menu in SmartPower, choose Modes and Scenarios > Use for Analysis > <scenario hame>; or
select the scenario in the Modes and Scenarios toolbar.

Note: When a scenario is selected, only the Summary tab is available.

To create a new custom scenario

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > New Custom
Scenario; or click Scenarios in the Modes and Scenarios toolbar, and select New custom scenario. This
brings up the New Custom Scenario dialog box.

2. Enter the scenario name, enter a duration (total duration for the sequence must equal to 100%) and select
previously defined operating modes for this sequence.

3. Click OK. The newly created scenario is set as default in the Modes and Scenarios toolbar.
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To edit a custom scenario:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > Edit Custom
Scenario; or right-click the scenario in the Modes and Scenarios toolbar, and select Edit custom scenario.
This brings up the Edit Custom Scenario dialog box.

Power - Edit Custom Scenario [Copy of 50% Flash*F... %

Duration [¥] Mode
a0 Active
a0 Flash*Freeze

L0 00 1| 0 O P L D —

Takal: 100 %

(R

Carrment:

| Copied from "S0% Flash*Freeze"
Help | Ik | Cancel |

Figure 31 - Edit Custom Scenario Dialog Box

2. Edit the information.
3. Click OK.

To copy a scenario:

1. Right-click the scenario in the Modes and Scenarios toolbar, and select Create a copy of this scenario.
This brings up the New Custom Scenario dialog box.
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Power - New Custom Scenario

Marme: _opey of scenariol

Duration [¥] Mode
20 Active
2l Sleep

000 | O O | LD D —

FY
v
Tokal: 100 %%

Carmment:

| Copied from "scenariol"

Help | Ik | Cancel |

Figure 32 - New Custom Scenario Dialog Box

2. Edit the information.
3. Click OK.

To delete a custom scenario:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > Delete Custom
Scenario; or right-click the scenario in the Modes and Scenarios toolbar, and select Delete Scenario. This
brings up the Delete Custom Scenario dialog box.

Power - Delete Custom Scenario E'

Choose the cuskom scenatio bo delete:

Help K, | Cancel

Figure 33 - Delete Custom Scenario Dialog Box
2. Select the scenario from the pull down and click OK.

Power Reports
The power report enables you to quickly determine if any power consumption problems exist in your design.

To generate a power report:

1. From the SmartPower Tools menu, choose Reports > Power Report, or click the Report button to
open the Report dialog box. By default, the report includes global design information and a power
summary.

2. Specify which results you want to display by selecting the categories and their options.

The power report dialog box is organized in the following panels: General, Operating Conditions, Options,
Breakdown by Instance, Frequency Summary, and Probability Summary.
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The general panel enables you to select what to include in the report, the report format, and the mode that you
want to generate the report for.

Power Report El
Selects Categor: |
B General
@ Operating Conditions Include in the report l;
B Options Pawer summary
,ﬁ Breakdown by inztance [[] Breakdovr by rail
EE? FquUEﬂ_CP Fummary [ Breakdown by type
al} Probahility surrnary [] Breakdown by clock damain
[ Thermal surmary
[] Battery life
[ Clock darnain surmmar e
[[] Operating condition summary -
Report Format: |Te><t j
Mode: |F\.ctive ﬂ i)
Help Ok | Cancel |

Figure 34 - SmartPower Power Report Dialog Box - General Panel

Include in the Report

Select the option(s) that you want to include in the Power Report:
Power summary — This section reports the static, dynamic and total power consumption of the design.
Breakdown by rail — This section shows the power consumption of each rail.

Breakdown by type — This section enables reporting on the power consumption according to: gates, nets,
clocks, core static, IOs and memories.

Breakdown by clock domain — This section enables reporting on the power consumption of each clock domain.

Thermal summary — This section includes a thermal report. The ambient temperature can be defined by the
operating conditions or defined by the ambient temperature.

When the first option is selected, the following characteristics are reported:
e Operating conditions
e Temperature range
e Junction temperature
When the second option is selected, the following characteristics are reported:
e Ambient temperature
e Cooling style
e Package
e Thermal resistance Theta-JA
e Junction temperature
e Temperature range
e Junction temperature range limits specification
Battery Life — This section reports the battery life.
Clock Domain Summary — This section reports the clock and data frequencies for each clock domain.
Operating Condition Summary — This section reports the operating conditions.
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Annotation Coverage - This section reports the number and percentage of pins annotated by each source (VCD,
manual annotation, SmartTime constraint, vectorless estimation, and fixed values) for all clocks, register outputs,

combinational outputs, set/reset nets, primary inputs, enable pins, and other pins

Report Format

Select Text or CSV (Comma Separated Value) as the desired export format.

Select a mode to generate the report for.

Operating Conditions

The Operating Conditions panel enables you to select the operating conditions for the current report.

Power Report E|
Select a Category: Operating Condition |
B General

Operating Conditions
B Dptions
4 Breakdown by instance
ity Frequency summary
Q.[} Probability surmmary

Caze! | Typical j

Help Ok, | Cancel

Figure 35 - SmartPower Power Report Dialog Box - Operating Conditions Panel

The Options panel enables you to select power and frequency units and to use toggle rates.
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Power, Report

1B General
&&| Operating Conditions

;ﬁ Breakdown by instance
e Frequency summary

- Probability summary L nits
Faower: e 2
Frequency: MHz -

[¥ Use toggle rates

Help [ o ]

Cahcel
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B

Figure 36 - SmartPower Power Report Dialog Box - Options Panel

Units
Frequency: Sets unit preferences for frequency - Hz, KHz, MHz.
Power Units: Sets unit preferences for power - W, mW, or uWw.

Use Toggle Rates

When toggle rates are active (Use Toggle Rates box is checked), the data frequency of all the clock domains is
defined as a function of the clock frequency. This updates the data frequency automatically when you update the
clock frequency. Toggle rates enable you to specify the data frequency as a percentage of clock frequency, but
you can no longer specify the data frequency as a number, only as a percentage of the clock frequency. To set

the data frequency again, clear the Use Toggle Rates option.

Breakdown by Instance

From this panel you can include the breakdown by instance in the report and set specific options.
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Power, Report ['S__<|
Select a Category: Breakdown by inst |
1B General
&&| Operating Conditions
5 Options v Include breakdown by instance
;ﬁ Breakdown by instance
&p Frequency summary [ Limit the number of reported instances to

Probability surmmar,
QB- Y Y [ Report only instances with power greater than ey

Sart by Power Yalues -
Sart arder: Descending hd

Help oK | Cahcel

Figure 37 - SmartPower Power Report Dialog Box - Breakdown By Instance Panel

Include breakdown by instance — This section shows the power consumption of each element that has been
instantiated in the design: gates, nets, memories, and 10s.

The breakdown by instance can be filtered by:
e Limit the number of reported instances to: will limit the number of instances reported to the specified
number.
e Report only instances with power greater than: any instance with power consumption below the selecte
value will not be reported.

This section can be sorted by selecting the preferred method:
e Sort by: Name (alphabetical) or Power Values
e Sort Order: Ascending or Descending
Note: The filter reduces the number of lines in the report, one per instance.

Frequency Summary
From this panel you can include the frequency summary in the report and set specific options.

& Microsemi

d

38



& Microsemi

a A%\ MicrocHIP company

SmartPower User Guide

Power, Report r'>__(|
1B General
&&| Operating Conditions
5 Options ) v Include frequency summary
;ﬁ Breakdown by instance
&p Frequency summary [ Limit the number of reparted pins ta

Probability surmmar,
QB- Y Y [ Report only pins with Frequencies greater than MHz

Sart by Frequency hd
Sart arder: Descending hd

Help oK | Cahcel

Figure 38 - SmartPower Power Report Dialog Box - Frequency Summary Panel

Include frequency summary — This section shows the frequency summary and reports the pin, net, domain,
frequency, and frequency source for each pin.

The frequency summary can be filtered by:
e Limit the number of reported pins to: will limit the number of pins reported to the specified number.

e Report only pins with frequencies greater than: any pin with a frequency below the selected value will
not be reported.

This section can be sorted by selecting the preferred method:
e Sort by: Pin Name, Net Name, Domain, Frequency, or Source
e Sort Order: Ascending or Descending

Probability Summary
From this panel you can include the probability summary in the report and set specific options.
Power, Report r'>__(|
Select a Category: Probability summa |
1B General
&&| Operating Conditions
5 Options v Include prabahility summmarsy

;ﬁ Breakdown by instance
£ Frequency summary

2~ Probability summary S ’h
: in Mame -
Sort arder: Descending -

Help oK | Cahcel

Figure 39 - SmartPower Power Report Dialog Box - Probability Summary Panel
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Include probability summary — This section shows the probability summary and reports the driver, net, rate,

source, and type for each pin.

This section can be sorted by selecting the preferred method:

e Sort by: Pin Name, Net Name, Rate,
e Sort Order: Ascending or Descending

74| fpga_igloo - Power Report

Source, or Type

File Actions Help

Power Report for design fpga igloo with the following settings:

(<l

Vendor: hotel Corporation

Program: hetel Designer Software, Release 5.4, Copyright

Date: Thu May 29 13:39:57 2008

Version: 3.o

Design: fpga_igloo

Family: IGLOD

Die: AGL&0OOVE

Package: 454 FEGA

Tewperature Range: CoM

Voltage Range: COM

Operating Conditions: Typical

Operating Mode: hotive

Data Source: havanced

Power Swansry

o o o +

| | Power (wmW)] | Percentage

- - - +

| Total Power | 21.733 | 100.0% |

| Ztatic Power | 0.156 | 0.7% |

| Dynamic Power | 21.577 | 99.3% |
o o o +

Ereakdown by Instance

o +-———— o o +
| | Type | Power (wll) | Macro
o +-————= o o +
| n445 | Net | 4.110 |

| 144 | I/0 | 0.638 | ADLIE:CLEEUF
| usz | IO | 0.638 | ADLIE:CLEEUF
| n453 | Net | 0.447 |

| UE3 | IS0 0.325 | ADLIE:INEUF
| LMDotIEyteCtrLd | Net | 0.300

| PLin & | MNet | a.z27e |

| Tioo | IO | 0.209 | ADLIE:QUTEUF
| Tio1l | I/0 | 0.209 | ADLIE:OUTEUF
| U104 | IO | 0.20%9 | ADLIE:OQUTEUF
| Tios | IO | 0.20%9 | ADLIE:QUTEUF
| Ti0& | I/0 | 0.209 | ADLIE:OQUTEUF
<

1989-2008

Figure 40 - SmartPower Report
In addition to the information selected on the Power Reports dialog box, the report contains global design

information.

Global design information: This section shows the target family, the package and the die. It also shows
information about the operating conditions, speed grade, and power mode. This option is set by default.
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Scenario Power Report

The scenario power report enables you to select a previously defined scenario and calculate the average power
consumption and the battery life for this scenario.
To generate a scenario power report:

Note: To generate a scenario power report, your design must contain one or more scenarios.

1. From the SmartPower Tools menu, choose Reports > Scenario Power Report, or click the Scenario
Power Report button to open the Power Scenarios dialog box. By default, the report includes global
design information and power sequencer summary.

2. Specify which results you want to display by checking the boxes to be included in the report.

The power report dialog box is organized in the following panels: General, Operating Conditions, Options, and
Battery Life.

General

The general panel enables you to select what to include in the report, the report format, and the scenario you
want to generate the report for.

Scenario Power Report E|
|
B General
@ Operating Conditions Include in the repart
B Dptions ‘Breakdown by rail
% Batter life Breakdown by type

Breakdown by mode
Operating condition summany

Report farmat; |Te:-:t j

Scenario; |scenari02 hd

Help Ok, | Cancel |

Figure 41 - SmartPower Scenario Power Report Dialog Box — General Panel

Include in the Report
Breakdown by Rail — This section shows the power consumption of each rail.

Breakdown by Type — This section enables reporting on the power consumption according to: gates, nets,
clocks, core static, |0s, and memories.

Breakdown by Mode — This section enables reporting on the power consumption by mode.
Operating Condition Summary — This section reports the operating conditions.

Report Format
Select Text or CSV (Comma Separated Value) as the desired export format.
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Scenario

Select a previously defined scenario to generate the report from.

Operating Conditions

The Operating Conditions panel enables you to select the operating conditions case for the current design.

Scenario Power Report [3__(|
Select a Category: Operating Conditions |
1B Gereral
Operating Conditions
B Dptions
[ Battery life

Caser | Typical j

Help k. | Cancel

Figure 42 - SmartPower Scenario Power Report Dialog Box — Operating Conditions Panel

Options
The Options panel enables you to select power and frequency units and to use toggle rates.
Scenario Power Report [3__(|
1B Gereral
@ Operating Conditions
J=N Options
[ Battery life
Lnitg
Power: o
Frequency: MHz =
Iv Use toggle rates
Help k. | Cancel
Figure 43 - SmartPower Scenario Power Report Dialog Box — Options Panel
Units

Frequency: Sets unit preferences for frequency — Hz, KHz, MHz.
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Power Units: Sets unit preferences for power — W, mW, or vW.

Use Toggle Rates

When toggle rates are active (Use Toggle Rates box is checked), the data frequency of all the clock domains is
defined as a function of the clock frequency. This updates the data frequency automatically when you update the
clock frequency. Toggle rates enable you to specify the data frequency as a percentage of clock frequency, but
you can no longer specify the data frequency as a number, only as a percentage of the clock frequency. To set
the data frequency again, clear the Use Toggle Rates option.

Battery Life

The Battery Life panel enables reporting of the battery capacity and the battery life. Enter a battery capacity in
MA/Hrs.

Scenario Power Report b—q

Select a Category: Battery life |

B General
@ Operating Conditions
B Dptions

[¥™ Batteny life

[¥ Include battery life

Eattery capacity: | 1000.00 méd * Hrs

Help Ok, | Cancel

Figure 44 - SmartPower Scenario Power Report Dialog Box — Battery Life Panel
The SmartPower scenario power report returns the average power consumption and battery life for this sequence.

43



SmartPower User Guide

74| fpga_igloo - Power_scenario Report

& Microsemi

a A%\ MicrocHIP company

EEX

File Actions Help
~
Soenario  Power Report for design fpga igloo with the following settings:
Vendor: hotel Corporation
Program: hotel Designer Software, Belease 8.4, Copyright (C) 19859-Z008
Date: Thu May 29 13:42:10 20035
Version: 3.0
Design: fpga_igloo
Family: IGLOO
Die: AGL&0OOVE
Package: 454 FEGA
Temperature Range: CoM
Voltage Range: COM
Operating Conditions: Typical
Data Source: hdvanced
Socenario Name: my_Scenario
S3ocenario Average Power
o o o +
| | Power (mW) | Percentage |
o o o +
| Total Power | 10.926 | 100.0% |
| Static Power | 0.138 | 1.3% |
| Dynamic Power | 10.788 | 95.7% |
o o o +
Battery Life
o B e e T T +
| Battery Capacity | 1000.000 mi*Hours |
o o +
| Battery Life | 207.803 Hours |
o o +
Ereakdown by mode
—— - - 4 +
| Mode | Power in the Mode (wW) | Duration | Power#*Duration Weight |
—— - - 4 +
| Mode Actiwve | 21,733 | s50.0% | 99.,5% |
| Mode 3tatic | 0,158 | 35.0% | 0.5% |
| Mode 3leep | 0,033 | 15.0% | 0.0% |
Fmm e o o +
w
< >

Figure 45 - SmartPower Scenario Power Report

In addition to the information selected on the Scenario Power Reports dialog box, the report contains global
design information, a mode summary and the sequence average power.

Global design information: This section shows the target family, the package and the die. It also shows
information about the operating conditions, speed grade and power mode. This option is set by default.

Power Summary: This section reports the power consumptio
default.

Sequence Average Power: This section reports the average
set by default.

n of the sequence by mode. This option is set by

power consumption of the sequence. This option is
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Cycle-Accurate Power Reports

Traditional power analysis based on a VCD simulation file reports an average power for the entire simulation time.
Based on a VCD simulation file, the cycle-accurate power analysis will report one power value per clock period (or
half-period) instead of an average power for the whole simulation. This feature allows to easily identify the worst
cycle in terms of power performance; and helps to understand and further minimize power consumption by
facilitating the analysis of data-dependent power variations, as well as dynamic power variations due to clock-
gating, or even clock frequency variations.

To generate a cycle-accurate power report:

1. From the SmartPower Tools menu, choose Reports > Cycle Accurate Power Report to open the cycle
accurate power report dialog box;

or

2. Select a vcd file from the Modes and Scenarios toolbar, and from the right-click menu, select Tools >
Power Cycle Accurate.

The cycle-accurate power report dialog box is organized in the following panels: General, Sampling Period, Partial
Parsing, Top-Level Name, Glitch Filtering, and History Size Reduction.

General
Cycle Accurate Power Report [5__(|
General

Sampling period
WD parsing ophions
Partial parsing

Tap level name WD files | D:hwarklcodetdesign_wved\EMotor, wed j IZI
Glitch filkering
Histary size reduction Report Format: Text -
|Jse operating conditions Fram; |.ﬁ.ctive j (i ]

Help k. Cancel

Figure 46 - SmartPower Cycle Accurate Power Report Dialog Box — General
VCD file - Select the VCD file you want to import.
Report format — Select Text or CSV (Comma Separated Value) as the desired export format.
Use operating conditions from — Select the mode from which the operating conditions will be used.
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Sampling Period
Cycle Accurate Power Report ['5__<|
Select a Category: Sampling period |
General

Sampling period

WCD parsing optians
Fartial parsing
Tap level name
Glitch filkering

Hiztory size reduction

Help
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(% Autornatic detection From clock: Pt _cl, -

{* Compute an average value per clock period

(" Compute an average walue per half clock period

(" Specify:

e
e m—

aF. | Cancel |

Figure 47 - SmartPower Cycle Accurate Power Report Dialog Box — Sampling Period

Automatic detection from clock — This option automatically detects the sampling period from the fastest clock.
You can also select any other clock in your design. You can specify whether the average value is computed per

period or half-period.

Specify — Select this option to specify the period and offset used to calculate the sampling period.

Partial Parsing

Cycle Accurate Power Report

Sampling period

WCD parsing optians
Partial parsing
Top level name
Glitch filkering

Hiztory size reduction

Help

Select a Category: Partial parsing
General

3
|

v Partially parse YWCD

Start time: 0.o0 ns
End time: 10000.00 ns

0K | Cancel

Figure 48 - SmartPower Cycle Accurate Power Report Dialog Box — Partial Parsing
Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be

used for large VCD files.
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Top-Level Name

Cycle Accurate Power Report

Select a Category: Top level name
General

3
|

Sampling period
WCD parsing optians
Fartial parsing

Tap level name
Glitch filkering
Hiztory size reduction

f*  Autarnatic detection

" Specify:

Help [ o ]

Cancel

Figure 49 - SmartPower Cycle Accurate Power Report Dialog Box — Top-Level Name

This option enables you to select how the top-level name is specified. Select Automatic Detection to let the

VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-
level name.

Glitch Filtering

Cycle Accurate Power Report

3
|

Select a Category: Glitch filtering
General

Sampling penod

WD parzing options
Partial parsing
Top level name

_ Elih::'u filtering  off
History size reduction

*  Autamatic glitch Filkering

" Specify filkering threshold:

Help [ o ]

Cancel

Figure 50 - SmartPower Cycle Accurate Power Report Advanced Options Dialog Box — Glitch Filtering

This panel enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by

entering a value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch
Filtering.
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History Size Reduction

Cycle Accurate Power Report

Select a Category: History size reductio
General

3
|

Sampling period

WCD parsing optians
Fartial parsing
Tap level name
Glitch filkering

Hiztory size reduction v Keep only local extrema

[ Set power threshold:

Help [ o ]

Cancel

Figure 51 - SmartPower Cycle Accurate Power Report Advanced Options Dialog Box — History Size Reduction

This panel enables you to limit the history size by keeping only local extrema or setting a power threshold.
The results are displayed in the cycle accurate power report below.
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Fa simple_PWM_B - Power_cycle_accurate Report EJE|E|
File Actions Help

Aotel Corporation — Actel Designer Software Release 2.4 (Version 2.4.0.0) s
Copyright (o) 1989-2005
Date: Thu May 29 13:53:58 2008

Design : siwple FPWH &

Family : IGLOO

Die @ AGLEOOVZ

Package : 256 FEGL

Tewperature Range @ COM
Voltage Range : COM

Uperating Conditions : Typical
Operating Mode : Static

Data Jource : Adwvanced

Wed File: Difwork/code/design wved/BMotor.wved

Max Power FEeport

o e et T o o +
| Cycle | 2tart Time (ps) | End Timweips) | Power (mll)

o e et T o o +

| 21 | Z0ooooo | 2100000 | 0.508

o e et T o o +

Cycle Based Power Report

e o B et o +

| Cycle | Start Time (ps) | End Timeips) | Power (mll)

e o B et o +

| 1 | O | 100000 | 0.101

| 2 | 100000 | Z0o0aoo | 0.161

| 11 | 1000000 | 1100000 | 0.161

| 13 | 1200000 | 1300000 | 0.za7

| 16 | 1500000 | 1600000 | 0.152 |

| 17 | 1600000 | 1700000 | 0.203 |

| 18 | 1700000 | 1500000 | 0.150

| 21 | 2000000 | 2100000 | 0.505 |

| 22 | 2100000 | 2200000 | 0.180

| 23 | 2200000 | 2300000 | 0.1585

| 24 | 2300000 | 2400000 | 0.1582 |

| 25 | 2400000 | 2500000 | 0.199

| 26 | 2500000 | 2600000 | 0.180

| 29 | 2800000 | 2500000 | 0.238

| 30 | Z900000 | 3000000 | 0.180

| 31 | 3000000 | 3100000 | 0.158

| 32 | 3100000 | 3200000 | 0.152 | w
£ >

Figure 52 - SmartPower Cycle Accurate Power Report

Activity and Hazards Reports

Traditional Power Analysis based on a VCD simulation file reports an average power value that will account for all
nets switching in the design. This switching includes functional transitions and spurious transitions. Due to the
delay of each gate, paths arriving at one internal gate may have different propagation delays. Therefore, a gate
may exhibit multiple spurious transitions before settling to the correct logic level. The Activity and Hazards Power
Report allows to quickly identify gates and nets of the design that consume power because of spurious
transitions. This is helpful to understand and further minimize power consumption. The activity and hazards report
reads a VCD file and reports transitions and hazards for each clock cycle of the VCD file.

To generate an activity and hazards power report:
1. From the SmartPower Tools menu, choose Reports > Activity and Hazards Report;
or
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Select a vcd file from the Modes and Scenarios toolbar, and from the right-click menu, select Tools >

neral, Partial Parsing, Top-

Level Name, Glitch Filtering, and Clock Domains.

General

Activity And Hazards Power Report

Selecta Categony

General

WCD parsing optians WD Files | Dhworklcodetdesign_ved\EMotor, wed
Partial parsing
Top level name

Glitch filkering

Repart Format:

Texk -

=1 L]

Clock damaing |Jse operating conditions Fram; |F\ctive

~ o

Report type: Report by Met - summary

For each net, report activity and power

sort by kotal power; sort order descending;
Limit: the number of reported nets bo 40,

Help

DK

[

Cancel

Figure 53 - SmartPower Activity and Hazards Report Dialog Box — General

VCD file — Select the VCD file you want to import.

Report format — Select Text or CSV (Comma Separated Value) as the desired export format.
Use operating conditions from — Select the mode from which the operating conditions will be used.

Report type — Select the report type:

e Report by net — summary: summary report by net
e Report by net — detailed: detailed report by cycle
e Report by cycle — summary: summary report by net

Report by cycle — detailed: detailed report by cycle

The selected report type reports activity and power for each net sorted by power in descending order and

limits the number of reported nets to 20 by default. To change these option
the pop-up menu, select the desired option:

Report: Select the query report type: activity, power, or activity and power.

Sort by: Select the query sort by functional power, functional transitions, spur
transitions, or total power.

Sort order: Select the query sort order: ascending or descending.
Limit the number of reported nets: Enter the query filter limit.

s, click each option and from

ious power, spurious
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Activity And Hazards Power Report

Select a Category: Partial parsing

General

WD parzing options
Fartial parsing
Top level name
Glitch filkering

) v Partially parse YD
Clock domainzs

End time:

Help

Start time:
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3
|

0.o0 ns

10000,00 ns

Cancel
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Figure 54 - SmartPower Activity and Hazards Report Dialog Box — Partial Parsing
Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be

used for large VCD files.

Top-Level Name

Activity And Hazards Power Report

Select a Category: Top level name

General

WD parsing ophions
Fartial parsing

Top level name
Glitch filkering
Clock domains

" Specify:

Help

f* Automatic detection

3
|

.

Cancel

Figure 55 - SmartPower Activity and Hazards Report Dialog Box — Top-Level Name

This option enables you to select how the top-level name is specified. Select Automatic Detection to let the
VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-

level name.
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Activity And Hazards Power Report

Select a Category: Glitch filtering

General

WD parzing options
Fartial parsing
Top level name

Clock domains ~ off

*  Autarmatic glitch Filkering

o]

" Specify filkering threshold:
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|

Cancel

Help

Figure 56 - SmartPower Activity and Hazards Report Advanced Options Dialog Box — Glitch Filtering

This option enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by
entering a value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch

Filtering.

Clock Domains

Activity And Hazards Power Report

Select a Category: Clock domains

General Clock domain

WD parsing ophions
Partial parsing
Top level name
Glitch filkering

* Automatic construction

(™ Specify:

T

3
|

T

Clock domain | Active clock Active edge

1 Pl true | riging id|
2 lunl_dataa_int_ME|true | rizing =

Cancel |

Help [ o ]

Figure 57 - SmartPower Activity and Hazards Report Advanced Options Dialog Box — Clock Domains
The clock domain can be automatically constructed or it can be specified by the user.

Automatic construction — This option automatically constructs the clock domain. SmartPower automatically

analyzes your design to assess if a clock is active and what is the active edge.
Specify — Select this option to specify the period and first edge.

Use the clock domain table to set the active edge (rising, falling or both) and to set a clock as transparent.

The results are displayed in the activity and hazards power report below.
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[l simple_PWM_B - Power_activity_and_hazards Report

Fil= Actions Help

Llc:t.ivity map report i

Aotel Corporation — Actel Designer Software Release 8.4 (Version 8.4.0.0
Copyright (o) 1989-2008
Date: Tue May 06 10:43:59 Z00S

Design : simple PUM &

Family : IGLOO

Die : AGLEOOVZ

Package : 256 FBGA
Temperacure Range @ COM
Voltage Range @ COM

Operating Conditions : Typical
Operating Mode : hctive

Data Source : Advanced

Ved file: D:/work/ecode/design wved/BMotor.ved

Aetivicy Map @0 Summary

| | Transitions | Dynamic Power (mW) |
| Total | 44184 | 0.155 |
| Functional | 32364 | O.128

| Spuricus | 11sz0 | 0.0z27 |

Aetivicy Map: Net Swanary

Functional | Spurious

Type | Functional | Spurious

| MNet Clock Domain

| | | | Transitions | Transitions | Power | Power

| | | | | | (i} | {mll} |

| PUM clk o | PUM clk | Clock | 5299 | 0 | 0.0%0 | 0.000 |

| PUM clk c O | PUM clk | Clock | 5993 | O | 0.018 | 0.000 |

| 2aux[0] | unl_datsa_int NE:Y | Data | 1 | 2986 | O0.000 | 0.013

| PUM_clk pad/U0/NET1 | PUM_clk | Clock | 58999 | o | 0.010 | 0.000

| Qaux[1] | unl_davsa_int NE:YT | Daca | 1 | 149z | 0.000 | 0.005

| un3_gaux_Ul_DWACT FINC_E[0] | PUM clk | Data | 746 | 0 | 0.003 | 0.000 |

| Qaux[Z] | unil datea int NE:¥ | Daca | O | 746 | 0.000 | 0.003 |

| Qaux[3] | unl_datsa int NE:¥ | Data | Z3 | 350 | 0.000 | O.00z2 |

| unl_dataa_int_0_1i | unl_dataa_int NE:T | Data | 1 | 2986 | 0.000 | D0.001

| I_42 | PUM_clk | Data | 2987 | o | 0.001 | 0.000

| I_S | PUM_clk | Data | 1494 | 0 | 0.001 | 0.000

| PWM_out_pad/U0/NET1 | unl_davea_int NE:T | Daca | 21 | 0 | 0.001 | 0.000

| uni_dataa int_1_1 | uni_datea_int NE:¥ | Daca | 1 | 149z | 0.000 | 0.001 |

| 1.9 | PUN clk | Data | 747 | 0 | 0.001 | 0.000 |

| Qaux[4] | unl_datsa int NE:Y¥ | Data | 2 | 154 | 0.000 | D0.001 |

| I_13 | PUM clk | Data | 373 | 374 | 0.000 | 0.000 |

| un3_gaux_N_Z2 | PUM_clk | Data | 746 | o | 0.000 | 0.000

| Qaux[s] | unl_davea_int_NE:T | Daca | 3 | S0 | 0.000 | 0.000 | v
< »

Figure 58 - SmartPower Activity and Hazards Report

Cycle-Accurate Power Analysis

The Cycle-Accurate Power Analysis reports cycle-accurate power data in a graphical form. In the analysis
window, you can specify ranges and compute averages for each range, define a list of watched blocks, obtain
power usage of a single block or cycle, or obtain power usage of multiple blocks over several cycles.
To generate a cycle-accurate power analysis:
1. From the SmartPower Tools menu, choose cycle-accurate Power Analysis;
or

2. Select a vcd file from the Modes and Scenarios toolbar, and from the right-click menu, select Tools > cycle-
accurate Power Analysis. The cycle-accurate Power Analysis dialog box appears.
3. Select the options you want to include in the report, and then click OK. The cycle-accurate power report
appears in a separate window.
The cycle-accurate power analysis dialog box is organized in the following panels: General, Sampling Period,
Partial Parsing, Top-Level Name, and Glitch Filtering.
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General

Cycle Accurate Power Analysis

Select a Category: General

General

Sampling period

WCD parsing optians
Fartial parsing

3
|

Lre Ny PO =\ For SmartPowerivishal F
Tap level name
Glitch filkering

. A3P 1000, ved e

Lse operating conditions From: Active j a

Help Ok, | Cancel

Figure 59 - SmartPower cycle-accurate Power Analysis Dialog Box — General
VCD file — Select the VCD file you want to import.

Use operating conditions from — Select the mode from which the operating conditions will be used
Sampling Period

Cycle Accurate Power Analysis

Select a Category: Sampling period |
General
Sampling period
YLD parsing DI:_'thS {s Automatic detection From clock: clk -
Partial parsing
qu lE\fEI r.wame {* Compute an average value per dock period
Glitch filkering

(" Compute an average value per half clock period

(" Specify:

T
P —

Help

OF. | Cancel |

Figure 60 - SmartPower cycle-accurate Power Analysis Dialog Box — Sampling Period

Automatic detection from clock — This option automatically detects the sampling period from the fastest clock.

You can also select any other clock in your design. You can specify whether the average value is computed per
period or half-period.

Specify — Select this option to specify the period and offset used to calculate the sampling period.
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Cycle Accurate Power Analysis

Select a Category: Partial parsing
General

Sampling period
WCD parsing options
Fartial parsing
Top level name |v Partially parse WCD
Glitch filkering
Start time:

End time:

Help
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3
|

0.o0 ns

10000,00 ns

o]

Cancel

Figure 61 - SmartPower cycle-accurate Power Analysis Dialog Box — Partial Parsing

Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be
used for large VCD files.

Top-Level Name

Cycle Accurate Power Analysis

Select a Category: Top level name
General

Sampling penod
WD parsing options
Partial parsing

Top level name
Glitch filkering

f* Automatic detection

3
|

" Specify:

Help

.

Cancel

Figure 62 - SmartPower cycle-accurate Power Analysis Dialog Box — Top-Level Name

This option enables you to select how the top-level name is specified. Select Automatic Detection to let the
VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-
level name.

55



SmartPower User Guide

& Microsemi

a A%\ MicrocHIP company
Glitch Filtering

Cycle Accurate Power Analysis

X
|
General
Sampling period
WCD parsing optians

Fartial parsing
Tap level name

Glitch filkering

" off

*  Autarmatic glitch Filkering

" Specify filkering threshold:

Help

0K | Cancel

Figure 63 - SmartPower cycle-accurate Power Analysis Advanced Options Dialog Box — Glitch Filtering

This option enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by
entering a value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch
Filtering.
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Cycle-Accurate Power Analysis Window

ll Cycle Accurate Analysis #1 |Z||E|fg|

k|~ "F‘E:\{ ':\5 | 3 b Add marker Time unit: |cvele number - @o ko cycle: | 18 Go
Analysis block: |F|:||_|_I;|:||:| j Settings summary

fpu_top =

16

-
s

Y
o K

power usage (mw)
o0

5 10 15 20 25 30 55
cycles
. 4 J
Select a cyele or a range (horizontal line) to get power usage
Power

Block (mW)
1 | fpu_tap -
2 uuT --
3 deb_inst --
WD File: Do fwarkfcodefFar SmartPowervishal_Fpu_AZP1000.vod Addfremaove watched blocks |

Help Close

Figure 64 - cycle-accurate Power Analysis

Mouse over a cycle to obtain the cycle number, the start and end times, and the power usage for the selected
cycle.

Use the Select button to select a cycle in the analysis, the grid displays the block name and power usage
for the watched blocks.

Us the Add Marker button to create cycle ranges — intervals between markers and/or the simulation ends.

To select a range, mouse over the average power usage horizontal line. This will display the average power
usage for the range.

To move to the beginning or end of a range, right-click the average power usage of the range and select Go to
Beginning of Range or Go to End of Range.

To move the marker to another cycle, click and drag the marker to another cycle; or from the right-click menu,
select Move marker, and enter a time value.

To delete the marker, right-click the marker, and select Delete marker.

To move to the previous or next markers, right-click the marker, and select Go to previous marker or Go to
previous marker.
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Use the Zoom In button to zoom in the analysis view.

&

Use the Zoom In Horizontal button to zoom in the analysis view.

=

Us the Zoom Out button to zoom out the analysis view.

—~

IOO'J.Q"

Us the

To view the most power-consuming blocks for a cycle, right-click the cycle, and select Show Most Consuming
Blocks for this Cycle. This opens the Biggest Power Contributors for Cycle window.

Zoom to Full View button to zoom into full view.

Biggest power contributors for, cycle 8

Power Y
Block (mW)
1 ha fpu_top 14,083
z2 T 0.257
3 UUTAu6/1I_0/U1 0,129
4 LUTAus/1I_0 0129
5 HUTAui 0,129
5] JUTAud 0,033
7 TS n.nz= b

Figure 65 - Biggest Power Contributors for a Cycle Window

To view the analysis for a specific time, enter a time value in the Go to time box, select the time unit, and press
the Go button.

To view the analysis for a specific block, select the block from the Analysis Block pull-down.
To export the cycle-accurate power analysis chart, right-click the chart, and select Export Chart to File.

You can modify the blocks you want to watch during analysis, by pressing the Add/Remove Watched Blocks
button.

If the operating conditions in SmartPower have been modified, a warning appears to indicate that the settings
have been changed. Click the hyperlink to regenerate the Cycle-Accurate analysis view.

Click the View Settings Summary button to display the cycle-accurate settings.
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Cycle Accurate Settings Summary [5_<|
Setting | Walue |
WD file O Awork Acodesfor SmartPowerfvish. ..
Dperating conditionz from mode Active
Sampling period autodetected from clock
Clock name clk
Compute average per peniod
Autodetect top level name brue
Fartial parzing brue
Start time 0.000 nz
Staop time 10000000 ne
Glitch filkering auto
Glitch filkering threshold 300 ps

Figure 66 - Cycle-Accurate Settings Summary

Click the Add/Remove Watched Blocks button to display a list of watched blocks . You can add or remove
watched blocks by checking or unchecking the Watch checkbox for that particular block(s) or by selecting blocks
in the grid and using the Check or Uncheck Selected Blocks buttons. You can use the filter options to hide or
display the list of blocks based on the criteria entered.

Watch blocks x|

Check below the block[z] you want to watch during cycle accurate analysis:
Block: |* Filter Show: AT ~

Block Watch -

fpu_top
JuT
deb_inst
T u3
UUTAuz
UTAu0
JUT Ao
T us
9 |UUTAul
10 |UUTAus
11 |UUT/ue/II_0

(n TS i R o R YR VR

LA e R

W

| | Select Al
Help ] | Cancel |

Figure 67 - Watched Blocks
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The Value Change Dump (VCD) file is a simulation file. The format of this file is specified in the IEEE 1364

standard.

You can configure the Project Manager to automatically generate VCD files using ModelSim.

You can also generate a VCD file with a ModelSim simulator using the following commands:

ved File example.ved

vced add -r /testbench/<top>_0/*
run 1 us

ved Flush

This example creates a VCD file example.vcd, adds all signals recursively, runs the simulation for one micro
second, and quits. You must quit ModelSim in order to get an accurate result from SmartPower.

If you have not yet completed the layout of the design, the design software guides you through place-and-route so
that you can import the VCD file. In order to successfully annotate your VCD values to the design, you must
complete place-and-route even if you generated your VCD file using timing simulation (pre-layout).

Note: SmartPower has been validated with VCD files generated by ModelSim. However, you may use any

Verilog/VHDL simulator that offers a VCD dump feature.

Refer to the user manual of your simulation tool for more information on how to generate a VCD file.

To import a VCD file:

1. From the Simulation menu, select Import VCD File. This opens the Import VCD Options dialog box.

Import ¥YCD Options

Select a Category:

General

WCD parsing optians
Partial parsing
Top level name

I

YD File: | Divworklcode'sub,wed

Glitch filkering
Remaining signals

Import in:

=

{*  Existing mode: |F\ctive

" Mew mode: |

Help [ o ]

Cahcel

Figure 68 - Import VCD File Dialog Box

2. Select the VCD file you want to import and select a mode to import it in, or click New Mode and enter a

mode name.
3. Select the options you want to specify:

Partial Parsing — Specify the Start and End Times to partially parse the VCD file. This option can be used

for large VCD files.
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Select a Category: Partial parsing

General
WCD parsing optians

Partial parsing

Top level name

Glitch filkering
Remaining signals

[ Partially parse WCD

Help [ o ]
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B

Cahcel

Figure 69 - Import VCD File Dialog Box — Partial Parsing

Top-Level Name — This option enables you to select how the top-level name is specified. The Top Level
Name is the instance name of your design instantiated in the simulation testbench.
Select Automatic Detection to let the VCD reader automatically detect the top-level name of the design, or

select Specify to manually specify the top-level name.

Import YCD Options

Select a Category: Top level name

General
WD parsing ophions
Fartial parsing

Top level name
Glitch filkering
Femaining signalz

+  Automatic detection

%]
|

" Specify: |

Help [ ok |

Cancel

Figure 70 - Import VCD File Dialog Box — Top-Level Name

Glitch Filtering — This option enables you to filter out pulses of short durations by selecting Automatic
Glitch Filtering or by entering a value in the Specify Filtering Threshold field. The default option is

Automatic Glitch Filtering.
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Import ¥CD Options
Select a Category: Glitch filtering
General

WCD parsing optians
Partial parsing
Top level name

Glitch filkering
Remaining signals

" off

* Autormatic glitch Filkering

" Specify filkering threshold:

Help oK | Cahcel

B

Figure 71 - Import VCD File Dialog Box — Glitch Filtering

Remaining Signals — Some signals may not be annotated by the VCD reader. This generally happens with

VCD files created from a behavioral or a post-synthesis simulation. For those signals, you can either

complete the annotation with the vectorless analysis or with the average values computed from the VCD file.

Import ¥CD Options
Select a Category: Remaining signals
General

WD parsing ophions
Partial parsing
Top level name
Glitch filkering

Remaining signals

¥ Use Vectorless analysis

" Use Average values camputed From YD

Help oK | Cahcel

%]

Figure 72 - Import VCD File Dialog Box — Remaining Signals
4. Click OK.

5.  When the vcd file is successfully imported, the file appears in the Modes and Scenarios toolbar, under the

imported mode.

Removing a VCD File

The Value Change Dump (VCD) file is a simulation file. The format of this file is specified in the IEEE 1364

standard.
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To remove a VCD file:

e Select the VCD file from Active mode or a custom mode, right-click the VCD file, and select Remove VCD
File from <mode name> Mode; or

e From the Simulation menu, choose Remove VCD File > <file name>

Note: Any annotation will be removed when you remove the VCD file.

See Also
Importing a VCD File
Modes and Scenarios Toolbar

Auditing Files
SmartPower checks the time stamps of the VCD file and reports any missing or out-of-date files.

Audit is performed automatically when SmartPower is launched. You can trigger file audit at any time from the
Simulation menu, by choosing Audit Files. An icon displaying the file status appears in the Modes and
Scenarios toolbar next to the VCD file. Mouse over the icon to obtain more information.

Modes and scenarios x

Modes

Active

& test2 vod
Flazh*Freeze
Sleep
Static
new_custom

o test vod

Scenarios

Figure 73 - Audit Files Results
Table 4 - Audit Files Icons and Descriptions

Icon Description
A Indicates that the VCD file has been modified
Q Indicates that the VCD file is missing

To re-import the VCD file, right-click the VCD file and select Re-import VCD File, this will open the_ Import VCD
Options dialog box.
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Calculating Power

Steps to Calculate Power

Use the steps below to calculate the power consumption of your design. The list of screens and steps appear in
the order in which you should view them to analyze your power accurately.

1. Summary tab — View global power at the design level and view its impact on junction temperature.

2. Domains tab — Define clock domains and specify a clock frequency and a data frequency for each clock
domain.

3. Analysis tab — View detailed hierarchical analysis of your power consumption. This step is optional. But if
your power consumption exceeds your budget, this step will help you to understand where there is room for
improvement.

4. Frequencies tab — Specify individual pin frequencies, this step is optional, but gives you pin-by-pin control of
the frequency.

5. Probabilities tab — Specify probabilities, this step is optional. You can use the default probabilities or set your
own.

Extracting Power Consumption of a Specific Clock Domain

To calculate the power consumption of a single clock domain (clock tree and data path) in a design:

1. Set SmartPower in toggle-rate mode. This is the default setting. To confirm that SmartPower is in toggle-rate
mode, choose Preferences from File menu. Select the Use Toggle Rates check box

2. Inthe Domains tab, set all the Clock Frequencies to zero except for the clock domain for which you are
calculating the power consumption.

The total power consumption of this clock domain is displayed in the Summary tab. This includes the contribution
of the clock buffer, clock tree, and all clock input of the registers of this specific clock domain.

Note: In case you need to determine the power of the clock tree only, set the toggle rate of data on that
clock domain to zero. The total power displayed is the power of that clock tree.

Advanced Analysis of 1/0s

SmartPower provides an easy way of estimating the power consumption related to 1/0s. You can then analyze
power consumption in detail.

To display I/0 power consumption:

1. Inthe Summary tab, select By Type from the Breakdown drop-down list. The grid displays the total power
consumption of all I/Os in the design, as well as all other components. If you use different I/O standards, and
different Vcci power rails, you can also display the power consumption for each rail by selecting By Rail
from the Breakdown drop-down list. Breakdown By Rail shows the power consumption and current for
each Vcci rail in the design.

2. Inthe Analysis tab, select the highest hierarchy level in the Hierarchy tree in the left pane. Select By
Instance from the Breakdown drop-down list.

3. Inthe Analysis tab, unselect all categories under Instances Contributions except I/0s, and then click
Apply. The table then displays a list of all I/Os in the design, along with the power contribution of each
individual I/O. The columns display important I/O attributes: external port name, load, standard, drive-
strength, slew, and macro.

4. Inthe Probabilities tab, you can control the output probability of each tri-state and bidirectional I/0. The
probability is the percentage of time that the 1/O is used as an output. The default value can be changed and
a specific value can also be set for each bidirectional or tri-state 1/O.
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See Also

Analyze results
Analysis tab

Define Clock Domains and Set of Pins

When you run SmartPower, it researches your existing clock domains and partitions your design automatically.
You may wish to review the list of clock domains in the Domains tab to ensure that all the clocks of your design
are included in the list. Add or remove clocks as necessary.

To add a new clock domain:

1. Click the Domains tab, and click the Add Domain button. Select Clock Domain from the drop-down list.
This opens the Create Clock Domain dialog box.

Create Clock Domain

52: 5I
Creat
Patertial Clock Pin |0 =TGR RN

Cancel
Clack Frequency I 10 tHz
Drata Freguency I 1 kHz

Figure 74 - Create Clock Domain Dialog Box — Toggle Rates Disabled

2. To create a new clock, select a Potential Clock Pin, specify a clock and data frequency, and click Create.
The new clock domain appears in the Domains window. If you select an existing clock pin from the drop-
down list, the lists of clock pins and data pins of this new clock domain are computed automatically based on
the netlist topology.

Note: Select Use Toggle Rates in the SmartPower Preferences to define your data frequency as a
percentage of your clock frequency. If your data frequency is 20% of your clock frequency, type "20"
in the Data Frequency text box.

Create Clock Domain

Create

Patential Clack Pin S ET AN

Clack Frequency I 10 tHz
Drata Freguency I 20 4

Figure 75 - Create Clock Domain Dialog Box — Toggle Rates Enabled

You may wish to create an empty clock domain and fill the lists of clock-pins and data pins manually. If so, do not
select a clock pin, just type a new name for your clock domain.

Beyond the verification of the list of clock domains, you may also wish to verify that the lists of clock pins and data
pins computed for each clock domain are correct.

i

Cancel

To verify the lists of clock pins and data pins of a clock domain:
1. Click the Domains tab and select a specific Domain in the list.

2. Display the list of clock pins or data pins of this Domain. A drop-down list in the Domains tab enables
you to select clock pins or data pins. SmartPower displays the list of pins corresponding to your selection
below the drop-down list. You can add or remove clock pins and data pins as necessary.

3. Remove a pin from a clock domain. Highlight the selected pin and click the Remove button. The pin is
removed from the clock domain and is made available in the list of pins that you can add in another clock
domain.
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4. Highlight the selected pin in the list of pins that are not yet in a domain and click the Add button to add a pin
in a clock domain. This pin is added to the clock domain. It is a clock pin or a data pin, depending on the
specification of the drop-down list when you click the Add button.

Note: You cannot add a pin that exists in another domain until you free it from its existing domain. The pin is
unavailable until you remove it from that domain.

After you have verified that all the clocks of your designs are correctly identified and constructed, you must
specify the correct clock and data frequency for each clock domain.

To add a new set of pins:

1. Open the Create Clock Domain dialog box. Click the Domains tab, and click the Add Domain button.
Select Set of Pins from the drop-down list.

Create Set of Pins

P
Creat
Set Mame IEIutpuﬂ
Cancel |
Frequency |1— tHz

Figure 76 - Create Set of Pins Dialog Box

2. Create a Set of Pins. Name your new set of pins, specify a data frequency, and click Create. The new set
of pins appears in the Domains window.

Specify Clock and Data Frequencies in SmartPower

To specify a clock and data frequency:

1. Click the Domains tab
2. select the Clock/Data frequency cell and type in a new value

SmartPower defaults to 0 MHz for the clock frequency. Import your clock frequency from SmartTime by using the
Initialize Frequencies dialog box in SmartPower or input your target for each clock frequency in the Domains
tab. You must also specify a data frequency (5% of your clock frequency is a typical guideline for your data
frequency — this corresponds to a toggle rate of 10 %.)

Not all the pins/gates/nets of your design are associated with a specific clock. For example, the frequency of a
design input port is not always correlated to a clock frequency. By extension, all pins that are upstream of the first
level of sequential elements are not associated with any clock. SmartPower creates an InputSet by default that it
uses to group all the pins that are controlled by design inputs (instead of sequential elements). You may wish to
view and verify the InputSet to further evaluate your design.

Viewing and Verifying the InputSet in SmartPower

To verify the InputSet:
1. Click the Domains tab and select the domain named InputSet in the list.

2. Verify the list of pins of this domain. All the input ports of your design (except the clocks) belong in the
InputSet. Also, all the pins that are between these input ports and the first level of sequential elements
belong in the InputSet. You can add or remove pins as necessary.

3. Specify an average input frequency. SmartPower uses the same frequency for all pins of the InputSet. The
default InputSet frequency is 1 MHz. Type in a new value to change it.

You may wish to split the InputSet into several sets in order to specify different frequencies. A classic example is
to create a ResetSet, a reset tree with a very low frequency.
To split the InputSet into several sets:

1. Create a new set of pins: In the Domains tab, click the New button, and select Set of Pins from the drop-
down menu. In the Create Set Of Pins dialog box, type a name and a frequency for the new set and click
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Create. The new set of pins appears in the Domains window. You can only create an empty set of pins, but
it is possible to add pins to this domain later.

2. Remove a group of pins from the InputSet. Click the Domains tab and select the domain named InputSet
in the list. Select the pins that you want to remove and click the Remove button.

3. Add this group of pins to the new set of pins. Click the Domains tab and select the newly created set of pins
in the list. Highlight the pins in the list of pins that are not yet in a domain, and click the Add button. Repeat
these three steps as necessary to create multiple input sets.

Specifying Individual Pin Frequencies
The Frequencies tab enables you to specify an average clock and data frequency for each clock domain, and also
an average frequency for each set of pins. This gives you an initial estimate of the power consumption of your

design. However, if this estimate is not accurate enough, you may refine it with a pin-by-pin annotation of the
frequency.

To specify a frequency annotation for an individual pin:

1. Locate the pinin the Frequencies tab. You may need to select different clock domains from the drop-down
list on the Frequencies tab. You can use filters to facilitate this search.

2. Select the pin(s) in the grid and click the Set frequencies for selected pins button, enter a new frequency
value, and click OK. This specifies a new frequency for the selected pin(s).

Note: This annotation procedure enables you to set the frequency of an individual pin, but this does not
mean that the pin is removed from its clock domain. A frequency annotation just overrides the domain
level frequency.

You may wish to change or remove a frequency annotation of an individual pin. This may be useful when you
import a VCD (value change-dump) file or a SAIF (Switching Activity Interchange Format) file.

To change the frequency annotation of an individual pin:

1. Locate the pinin the Frequencies tab. You may need to select different clock domains from the drop-down
list on the Frequencies tab. You can use filters to facilitate the search.

2. Select the pin(s) in the grid and click the Set frequency for selected pins button, enter a new frequency
value, and click OK. This specifies a new frequency for the selected pin(s).
To remove the frequency annotation of an individual pin:

1. Locate the pinin the Frequencies tab. You may need to select different clock domains from the drop-down
menu on the Frequencies tab. You can use filters to facilitate the search.

2. Select the pin(s) in the grid and click the Reset frequencies for selected pins button. This removes the
specified frequency from the selected pins.

Specifying Individual Pin Probabilities

The Probabilities tab enables you to specify the default output probability value for memory blocks, and tristate
and bidirectional I/Os. In addition, you can increase the accuracy of the power estimation by annotating the
probability of specific pins.
To specify or change the probability for one or multiple pins:

1. Locate the pin(s) in the Probabilities tab. You can use filters to facilitate this search.

2. Select the pin(s) and press the Set probabilities for selected pins button.

3. Enter a new probability value and press OK.

To reset the probability for one or multiple pins:

1. Locate the pin(s) in the Probabilities tab. You can use filters to facilitate this search.

2. Select the pin(s) and press the Reset Probabilities for selected pins button. This will reset the probability
value.
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Vectorless Estimation

The Vectorless estimation method is an accurate method of annotating individual pins with frequencies and
probabilities. It uses primary inputs, clock frequencies, and nets annotated with other methods as a starting point,
and uses a Monte Carlo simulation to annotate all nets in the design with frequencies and probabilities.

Vectorless estimation can be enabled from the Initialize Frequencies and Probabilities dialog box or from the VCD
Import dialog box. It can also be enabled through Tcl.

Changes to probabilities or frequencies in the Probabilities, Frequencies, or Domains tabs result in an out-of-date
|
vectorless estimation. To update vectorless estimation, press the refresh vectorless %~ button.

Viewing Results (Design Level)

Click the Summary tab to view global power consumption at the design level. The Summary tab shows your
design's estimated power consumption and temperature information.

The power estimation reported in the Summary tab is the total static and dynamic power consumption of your
design. For a more detailed view of this power consumption, click the Analysis tab.

To estimate the junction temperature:

1. Verify your package. You cannot change your package directly in SmartPower, because it may render your
place-and-route information (and thus it may severely impact the total power consumption). If you wish to
choose another package, you have to do it in Libero.

2. Click the Summary tab, and select a Cooling style in the list. Thermal resistance changes automatically
when you update the cooling style.

3. Specify an ambient temperature. Enter an ambient temperature (default value is 25°C), and click the Set
button.

Note: The junction temperature value changes according to the package, cooling style, and ambient
temperature values you choose.

Analyzing Results

The Analysis tab displays the estimated power consumption of individual blocks, gates, nets, 1/0s, and memory
and enables you to make a hierarchical analysis of your power consumption. The Analysis tab may also help you
to improve your power consumption by identifying the components that consume a significant amount of power.

To identify the components consuming the most power:

1. Use the Analysis tab to expand the design hierarchy. The Analysis tab enables you to expand your design
hierarchy and view a complete list of the blocks in your design. In the hierarchy window, click the + next to
your design to view the items in the hierarchy. Click the + next to a sub-block to view its sub-elements.
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Figure 77 - Analysis Tab Dialog Box

2. Click to select a block. By default, SmartPower selects the design-level block, but you can always select
another block in the hierarchical tree. The Report window displays the list of sub-elements of the selected
block. Initially, this list includes all sub-elements. The grid in the Analysis window displays a breakdown of
the power of the selected block by type. This breakdown provides you a good overview of which areas of
your design you should optimize for power.

3. To find the components that use a significant amount of power, choose By Instance from the Breakdown
drop-down list.

4. Sort and filter the sub-elements to find the component that is using the most power. The Analysis window
displays the list of sub-elements of the selected block. By default, this list includes all sub-elements. The grid
contains columns for name, type, power, driver, fanout, macro, I/O standard, output load, output drive, slew,
port, domain and frequency. You may limit the list of sub-elements to a list of sub-blocks, nets, gates, 1/0s,
memories, or any combination of these five classes of sub-elements. You can sort the list according to any
column by double-clicking the column header.

See Also
Advanced Analysis of 1/0Os
Analysis tab

SmartPower Calculation Equations

SmartPower calculates the static power and the dynamic power of your design, for given operating conditions and
operating modes:

Static Power: This value is a summation of the static power consumed by each element of the design.
SmartPower provides a static power consumption of the array. This value is die-dependent. This value is also a
function of the operating mode. For some families, SmartPower also considers a static power contribution per 1/0O
bank. For specific 1/0 technologies like voltage referenced 1/Os or differential I/Os, SmartPower also considers a
static power contribution per 1/O.

Dynamic Power: This value is a summation of the dynamic power consumed by each element of the design
(nets, modules, I/Os, RAMs, FIFOs, PLLs, etc.).
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Operating Conditions: SmartPower calculates power consumption in Worst, Typical, or Best operating
conditions. SmartPower uses the following as general guidelines:

e |t applies a voltage derating to dynamic power contributions. Higher voltage typically leads to higher power
consumption.

e It applies a temperature derating to static power contributions. Higher temperature typically leads to higher
power consumption.

e |t applies no radiation derating.

Operating Modes: SmartPower calculates power consumption in Active, Static, Flash*Freeze, Sleep, and
Shutdown operating modes, when applicable for your design.

Sample Equations:

The examples below are for general evaluation purposes only. They are not a precise representation of the actual
calculations, since each calculation takes into account family-specific information.

e [oranet,
P=cC- 12 F
where C is the total capacitive loading of the net (extracted from the routing topology), V is the net's voltage
swing, and F is the average switching frequency.

Note: For the ProASICELUS family, SmartPower extracts the capacitive loading of a net from a Wire Load
model.

e For amodule, the power is computed using a characterized library (by family and die-size) describing a
specific power model for each type of module. For example, the power model of a flip-flop is given by

o 1] i o ¥ . n ¥ i n
P=1 CK ! CK + ‘FDG{;T f DQ.[_.-T"' 4 Din ‘JDU:
where Fck is the average clock-input frequency for this flip-flop, Foour is its average data-output frequency,

and Pck, Poour, poin are three constants estimated by electrical simulation and silicon characterization for this
flip-flop module, and FDin is its average data-input frequency.

e For an I/O, the formula used for computing the power consumption depends on the I/O technology and the
family. For example, for a TTL ou%put, the dynamic power is given by
P=Pyr F+C- V2. F
where C is the output load (derived from what you have set in the I/O Attribute Editor GUI, typically 35 pF for

TTL), V is the output's voltage swing (3.3 V for TTL), and Pint represents an internal power contribution
dissipated in the pad, and F is the average switching frequency of the I/O.

e Foracomplex block, like a RAM, a FIFO, or a PLL, SmartPower uses a high-level power model that
integrates design parameters.

SmartPower automatically computes all the constant parameters of these equations. However, the frequencies
depend on the target frequencies of your design. Since it is impractical to enter each frequency manually,
SmartPower has several flows that help you to estimate the frequencies and calculate the power consumption.
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SmartPower Tcl Commands

For details about the Tcl commands supported by SmartPower, refer to the SmartFusion2, IGLOO2, RTG4 Tcl
Commands Reference Guide or the PolarFire FPGA Tcl Commands Reference Guide.
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Data Change History - SmartPower

The data change history report lists power data updates up to the current release that may impact the power
consumption of the design.

To generate a data change history report, from the Help menu, choose Data Change History. This opens a data
change history report in text format.
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